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From fast-moving action to rich 4K HDR video, the new Nikon D780 helps your vision take flight. Its unique combination of
autofocus systems offers the best of both worlds. Optical viewfinder shooting gives you fast and accurate AF with flagship
tracking capabilities. Whilst live view shooting brings all the advantages of focal-plane phase-detection AF technology,
including eye-detection AF and 273 focus points. Combined with shutter speeds from 1/8000 to 900 seconds, and advanced
video and time-lapse features, the D780 embodies true versatility.
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WELCOME TO THE NOVEMBER 2020issueof DigitalSLR
Photography.Aswegotopress,theautumnequinoxhasarrived,
signallingtheendofsummerandthestartofarguablythemost
popularseasonforlandscapephotographers.Overthenextfew
weeks,we’llbewitnesstotheamazingtransformationoffoliage
fromlushgreenstogloriousgold.Withthedaysgettingshorter

andtheweatherbecomingvolatile, it’stheperfecttimetoheadouttocapture
scenesofgoldfilledwithmagical lightandsensuousmood.Inthismonth’s
PhotoExpert (page54)regularcontributorRossHoddinottprovidesuswith15t
ofhisfavouritetipstohelpyoucaptureyourbestautumnalimages.Rossisalso
featuredinour BigInterview (page74),whereheandtopwildlifephotographerw
BenHalltalkabouttheir latestbook, 52Assignments:NaturePhotography.With
Halloweennotfaraway,wethoughtwe’daddalittlespookyshootingintoour
PhotoSkills ensemble,soifyou’reafanofthemacabre,trycreatingyourowns
ghostlyimagesusingCarolineSchmidt’sadviceonpage30.Ifyou’refaint-
hearted,don’tworry,we’veconventionalsubjectstoo,includingstill-lifesand 
cityscapes.Wewishyoua great monthofphotography.Allthebest!

Daniel Lezano Editoro
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Ourstunningcoverimageof
twoGreatCrestedGrebes in
goldendawnlightwas
capturedbyleadingwildlife
photographerBenHall.We
speaktoBenandRoss
Hoddinottabouttheirlatest
book,52Assignments:Nature
Photography, inthismonth’sy
BigInterview,startingonp74. 

JOINCLOSETO600,000FOLLOWERS!Getonlineandinteractwiththeexperts at DigitalSLR
Photography. You can follow us on Facebook (facebook.com/digitalslrphoto), tweet us on
Twitter (@digitalslrphoto) or email us (enquiries@dslrphotomag.co.uk) to keep up to date witha
that's going on in photography. Don’t miss our blog, too, at: www.digitalslrphoto.com.

Join a growing community

all

Welcome

GetyourmonthlyfixofDigital
SLRPhotography inspirationy
andadvicedirect toyour
doorormobiledeviceby
subscribingtoourprintand/
ordigitaleditions.Turnto
page96forthelatestmoney-
savingofferforsubscribers!
Forfurtherdetails,visit:
www.digitalslrphoto.com.
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Caroline Schmidt
A professional photographer and
experienced journalist, Caroline
brings her talent for creating
inspiring content to every issue.
carolineannphotography.co.uk

Daniel Lezano
With around 35 years’ experience
as a photographer and over 25 years
on photo magazines, editor Lezano
is passionate about photography,
in particular portraits. 

Ross Hoddinott OUTDOOR
He’s not only an award-winning
nature photographer, a leading
expert in landscape and wildlife
photography, he’s a top tutor, too. 
rosshoddinott.co.uk
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“This is a less photographed view of the beautiful Buttermere  
on my way up Haystacks via Scarth gap with a group of friends.  

As I was obliviously making my way up the path, one of my friends 
advised me to turn around to see the stunning light. I grabbed a 

few shots and then it was gone. It goes to show you should often 
check out what’s going on behind you as well as in front.“

Pentax K1 with Pentax 28-105mm f/3.5-5.6 lens. Exposure: 1/400sec at f/7.1 (ISO 100).

Scarth Gap by Royce Meckin
www.instagram.com/royce__06/







(Centre right) “This is one of my favourite shots from my many visits
to Buttermere, with Char cottage again nestled in there. This
morning I made a last minute decision to head out before going
to work on a back shift and unusually for me I sat and waited for a 
shot, rather than hunting one out. The light and weather was 
changing so quickly but I managed to keep dry.“
PentaxK1withTamron70-200mmf/2.8 lens.Exposure:1/200sec at f/7.1 (ISO 100).

Buttermere Squall byRoyce Meckin

(Left) “This little fell is one of my favourites due to its short walk to
the top and 180° views from its peak, which makes it my go-to fell
when wanting a walk when I'm short of time. Once up there the
light seems to fall perfectly on the surrounding fells all year round 
meaning I’ve never failed to get a shot I like.“
Pentax K1 with Pentax 28-105mm f/3.5-5.6 lens. Exposure: 1/640sec at f/7.1 (ISO 100).

Whiteoak Beck byRoyce Meckin

(Below right)“This is a shot of Char Cottage that I had tried to get
numerous times before, failing due to choppy water or lack of
knowledge and ability when starting out. Thankfully, after lockdown
was eased this was my first port of call and the conditions were
ideal. The evening light only comes down the valley in the height of 
summer so makes a rarer photo of a popular scene.”
Pentax K1 with Pentax 28-105mm f/3.5-5.6 lens. Exposure: 1/10sec at f/10 (ISO 100).

Char Cottage byRoyce Meckin

(Above) “Taken from the summit of Loweswater Fell overlooking
Buttermere and Crummock in Cumbria, this images was shot the
same day as the Whiteoak Beck image (right). The conditions were
promising for patchy light and a chance of rain. Unfortunately, the 
rain never materialised but I had dramatic clouds instead.“
Pentax K1 with Pentax 28-105mm f/3.5-5.6 lens. Exposure: 1/160sec at f/7.1 (ISO 100).

Crummock Vista by Royce Meckin
www.instagram.com/royce__06/

Portfolio
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(Below left) “This stellar figure is the result of a milk-drop collision,
and unlike the other photographs within this portfolio that have
been created with food colouring, the blue colour was created by
a coloured gel on the flash units. The moving liquid drops provided 
the energy to create a cosmic-like disturbance in the catch
receptacle, which was also filled with milk.“
CanonEOS5DSRwithEF100mmf/2.8Lmacrolens.Exposure:2.5seconds at f/16 (ISO 640).

Cosmic Splash byMichael McKenney

(Left) “Food colouring was used in a water and milk mixture to
create this image. A simple crown shape was created by the first
drop that landed in the catch receptacle. Other drops are visible as
they make their way down to the crown. If I had snapped a single
micro-second later, this image would have taken on a different
shape entirely and this image would have been lost forever.“
Canon EOS 5DS R with EF 180mm f/3.5L macro lens. Exposure: 1.6 seconds at f/11 (ISO 200).

Splashdown byMichael McKenney

(Right)“A pressurised burst of water and milk shot up from the catch
basin to create this image. Overhead falling drops were also a water
and milk mixture coloured with food colouring. All splash images 
are unique and can never be duplicated because of the ever-
changing variables involved in the creation of the images.“
Canon EOS 5DS R with Laowa 24mm f/14 macro probe lens. Exposure: One second at f/22 (ISO 400). 

Old Faithful byMichael McKenney

(Above) “Albuquerque is home to thousands of pigeons, but it was
still a surprise when this figure appeared from colliding drops of
lightly-coloured water. I used two flash units set at 1/128 power,
which is my usual set-up, to light from behind in a darkened room, 
giving me an effective exposure of 1/20000sec.“
Canon EOS 5DS R with EF 180mm f/3.5L macro lens. Exposure: 1.6 seconds at f/11 (ISO 200).

The Rock Pigeon by Michael McKenney
splashartbymike.com

10 Digital SLR Photography November 2020

Portfolio







(Below right) “Many people see a vase or a cup in this image, which
was created by the first two drops colliding into a catch receptacle
filled with a water and milk mixture. The third drop is 'caught' by 
the figure made by the first two drops.“
CanonEOS5DSRwithEF180f/3.5macrolens.Exposure:Twoseconds at f/14 (ISO 250). 

The Catch byMichael McKenney

(Right) “A photographer can choose which liquids to use for a drop
collision and colour those liquids any way they choose, but it is still
impossible to predict what the results might be. In this case, I see
the water-milk drop collision having taken the shape of a baby
elephant. What one person sees in an image though may be
entirely different from another’s perception of that same image.“
Canon EOS 5DS R with Laowa 24mm f/14 macro probe lens. Exposure: One second at f/22 (ISO 320). 

The Baby Elephant byMichael McKenney

(Left) “Covid-19 has caused many photographers to look for
alternative ways to create unique images away from groups of
people. Splash photography has been the solution for some.
Many of the stunning, stop-motion images created during splash
photography invoke feelings of peaceful melancholy, which is the
case for 'Star Gazer'. It is a water and milk collision that has resulted
in a lone, human-like figure staring out into a starry night sky.“
Canon EOS 5DS R with Laowa 24mm f/14 macro probe lens. Exposure: 1.6 seconds at f/22 (ISO 400). 

Star Gazer byMichael McKenney

(Above) “The mushroom shape in this shot was created by the first
two drops of a water and milk collision falling into the catch
receptacle, which was also filled with a water and milk mixture.
The third drop has created a shadow on the top edge of the 
mushroom. Three different colours were used.“
Canon EOS 5DS R with EF 180mm f/3.5 lens. Exposure: 1.6 seconds at f/16 (ISO 200).

An Illuminated Shadow by Michael McKenney
splashartbymike.com

Portfolio
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Take your professional photography to new heights and never get weighed down.

The new Olympus E-M1 Mark III is amazingly compact and lightweight and fits perfectly in your hand.
It packs pro-level technology and superior image stabilization – so you’re free to go further with your handheld shooting style.

With uncompromising image quality and weathersealed construction, the E-M1 Mark III is your ultimate tool for getting the 

breathtaking results you want in all conditions – from nature, landscape, and night shots to videos.

Find out more at your local Olympus retailer or go to olympus.co.uk #breakfreewitholympus

NO LIMITS. BREAK FREE.
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CREATIVE 
PENCIL ART

COLOURING PENCILS ARE NOT JUST A RAINY-DAY 
STAPLE FOR CHILDREN – BUY A BOX TO EXPLORE WHAT 

COLOURFUL STILL-LIFE POTENTIAL AND HOURS OF 
PLAY THEY CAN OFFER PHOTOGRAPHERS TOO

CAMERA: NIKON D750/ LENS: TOKINA 100MM F/2.8 
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Colour-filled still-life
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1SET-UP:A dark background like a large sheet of black card or dark
floorboards is ideal for this set-up, which is best positioned under a

large window for soft, low-contrast lighting. It's important to use a
new pack of colouring pencils unless you want to make extra work for
yourself sharpening pencils consistently or erasing flaws in post-
production. Try to use a new metal pencil sharpener as the point of
focus, too, as a macro lens will pick up the slightest of dirt and marks. 

3LIGHTING:Diffused, even lighting like window light makes colours
more vibrant compared to a hard light of higher contrast, which can

leave some colours looking washed and uneven if you're not careful.
If the set-up is side-lit, use a reflector on the opposite side of the light
source to help fill in shadows cast by the sharpener. Position the
camera overhead and use LiveView to help refine the composition;
keep the camera parallel to the set-up to maximise depth-of-field.

2COMPOSITION:Take some time to consider your colour combination
and the pattern you want to create before interlocking pencils tips;

you’ll need in the region of 40-50 pencils. Interlace the pencils points
so that they lay flush to each other with minimal gaps and try to align
the edges of the wood casing for straight lines. It can help to use a strip
of double-sided sticky tape to keep them in position, too. Carefully
and evenly graduate the pencils away from the top of the sharpener.

4CAMERA SETTINGS:Set manual or aperture-priority mode and dial in
f/8 or smaller to achieve sufficient depth-of-field. You may need to

use a tripod if your exposure is too long to shoot handheld, especially
as you'll need to slightly underexpose to retain a darker background.  
A remote release or the self-timer mode can help you to avoid
introducing camera shake, too. Play with apertures and camera
distance to find the best balance of sharpness for your macro shots. 

I
F YOU READ last issue’s Photo Expert by
pro photographer Ross Hoddinott, you’ll
already have an understanding about the
power colour has in photographs. Bold

colours and patterns can be found almost
everywhere you look, both natural and
man-made, and when isolated with a close-
focusing lens they can make for compelling
abstracts and still-life photographs.

Colouring pencils are often overlooked as
they're such common household subjects, 

but they're versatile and not only work well
as vibrant props but allow you to explore
the impact of combining contrasting or
complementary hues and shades.

As we enter what is many photographers'
favourite season, most admired for its vibrant
and warm hues, there will hopefully be plenty
of opportunity for outdoor photography
before a more monochrome winter sets in.
However, autumn can also be one of the
year’s wettest seasons so having a colourful 

indoor still-life like this in your back-pocket
means you won't have to stop shooting.
As close-up photography is very unforgiving, 
still-life ideas like these can be enough
to keep you busy for minutes, hours and
even days – they're an exercise in patience,
attention to detail and creativity that calls
on solid composition, pin-point focusing
and design skills without having to leave the
house. So, grab a colour wheel and a stack of 
colouring pencils, and let’s get shooting. 

NO REFLECTOR WITH REFLECTOR



SHARPENING YOUR SKILLS
Paycloseattentiontothetiniestofdetails,
likethealignmentofprops,shadowsand

unwantedmarks,astheyhaveabig impact. 

Exposure:1/25sec at f/10 (ISO 800)



LOW-LEVEL 
CITYSCAPES

CAPTURE THE CITY FROM A MOUSE’S EYE VIEW USING A MINI-TRIPOD TO GET AS LOW 
TO THE GROUND AS POSSIBLE. JAMES ABBOTT GUIDES YOU THROUGH THE PROCESS 

CAMERA: SONY ALPHA 7R III / LENS: SONY FE 16-35MM F/2.8 GM 

 POUNDING THE PAVEMENT is a common 
activity for photographers seeking out 
enticing compositions of both new and 

well-known locations. One of the most difficult 
aspects of shooting popular locations is that 
there’s often a tried-and-tested formula for 
getting the ‘money shot’, but simply replicating 
something you’ve seen before is rarely as 
satisfying as shooting a well-known location 
from a new and unusual angle.

One way to change your shots is to vary the 
viewpoint of the camera; it could be as simple as 
finding a different angle, shooting from higher up 
than usual or even close to the ground. In this 
technique, we’re going to focus on shooting low 
to the ground because of the dynamic and 
indeed unusual results it produces of honey-pot 
locations such as Senate House Passage in 
Cambridge, seen here from a low angle. 

Kit-wise, you can use a standard lens, but you’ll 
be able to capture a wider field-of-view with an 
ultra wide-angle zoom, such as a 10-24mm on 

APS-C or 16-35mm full-frame. Filters are also 
useful – ideally a polariser to help maintain the 
blue of the sky and a soft graduated ND to retain 
sky detail, without darkening buildings too much 
when shooting in narrow streets. Other than this, 
a table-top tripod is also extremely useful.

Mini-tripods are those that are small enough 
to fit in your pocket. Not only are they useful for a 
variety of photographic subjects, they’re 
incredibly lightweight and compact, which 
means they’re great to carry when a full-size or 
even travel tripod is out of the question. 

The mini-tripod used here was an Andoer 
table-top tripod – it features an Arca Swiss head 
so L brackets can be used with it, but other 
mini-tripods are available from Joby, Manfrotto 
and Vanguard to name but a few. Mini-tripods 
make this technique much easier to shoot 
because you’re immediately low to the ground, 
but you can also insert the centre-column of a 
full-size tripod upside down to secure the 
camera low to the ground, albeit upside down.

PH O
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1) TOO MUCH FOREGROUND:
In this image, the camera was
tilting forwards so too much
pavement was included in the
shot’s foreground and distortion
is visible in the vertical lines at
the back of the scene.

2) STANDARD TRIPOD HEIGHT:
Shooting with a full-size tripod
at ‘standard’ height has resulted
in a perfectly good image, but it
lacks the dynamism of the shot
taken low to the ground.

3) THE PERFECT BALANCE:
The imagetakenwiththecamera
onamini-tripodhasproduced
themost interestingresult,
balancingthecharacteristicsof
the two shots that didn’t work.
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Low-level cityscapes

1SET UP:Attach your camera to your tripod and compose the shot.
With the camera so low to the ground it can be incredibly difficult

to compose using the LCD screen, so an element of trial and error is
essential. Use the virtual horizon to ensure the camera is level and take
test shots to assess composition. If this doesn’t work, you may need to
cover the camera to see the screen and you can focus on the brighter 
elements of the scene to assist with composition.

2USE FILTERS:Filters are always useful for cityscape photography and
for this technique the humble polarising filter is a great way to help

maintain the blue of the sky. Sometimes this is enough, especially if
the street is brightly lit, but if not a soft graduated ND filter can
maintain sky detail when the ground is a few stops darker than the sky,
which is often the case. A soft ND grad is ideal because it will have a 
lesser effect on buildings than a medium or hard grad.

3CAMERA SETTINGS:Shoot in aperture-
priority with an aperture around f/11 at ISO

at 100. This will provide a reasonably large
depth-of-field, but the area immediately in
front will be slightly out of focus once the
lens is focused. It’s not a problem and actually
looks better with the immediate foreground
slightly out of focus because it stops the
viewers’ eye from focusing on the
foreground when the mid-ground and
background are the focal points of the image.

4FOCUS AND ADJUST:Manually focus as you
would for any landscape or cityscape

image – one-third of the way into the scene
beyond the foreground you want to be sharp.
Although, as previously mentioned, the
ground just in front of the camera will be
slightly out of focus. Next, use the LCD’s live
histogram to assess exposure and apply
exposure compensation, or take a test shot
and check the histogram. This shot needed 
-1/3EV to maintain sky detail.

5USE THE SELF-TIMER:To release the shutter,
you can use a shutter remote – wireless

models are better so you don’t have to stoop
down for the cable. But an equally effective
method is to use the camera self-timer. Set
the timer to a two-second delay and take
multiple shots with or without people in the
scene. If it’s busy, you may have to wait
patiently for a clear scene or if your desired 
location is nearly always busy, shoot at
sunrise instead to avoid the crowds.

GETTING IT RIGHT IN-CAMERA

1 2 3



HOW LOW CAN YOU GO?
Avari-angleLCDis invaluablewith

low-levelshotsso, ifyouhaveone,
useitwithLiveViewtomakeiteasier.

Exposure:1/6sec at f/13 (ISO 100)





CAMERA:SONYALPHA7RIV/ LENS: SONY FE 90MM F/2.8 MACRO G OSS

LIQUID LENSES
TURN LIQUID DROPLETS INTO MINIATURE LENSES THAT ISOLATE AND MAGNIFY COLOURFUL 

SUBJECTS. JAMES ABBOTT SHOWS YOU HOW TO SHOOT THIS FUN MACRO TECHNIQUE…

 W ATER AND MACRO photography are 
a popular combination. Whether 
sprayed onto subjects to replicate 

dew, capturing high-speed water droplets 
as they crash on a liquid surface or using 
droplets as the subject themselves, there 
are seemingly countless ways water can be 
incorporated into close-up photography. In 
this technique, we’re going to focus on the 
latter using the effects of refraction.

Refraction is the change in the direction 
of light when it passes from one medium to 
another, such as from air to water, and is 
why when you drop a pencil into a glass of 
water the section poking out of the water is 
out of line with the section underwater. It’s 
because the light waves move more slowly 
through water than through air.

You can apply this to macro photography 
by placing water or glycerine droplets onto 
a small sheet of clear Perspex or glass, 
which causes each droplet to essentially 
become a fisheye lens and bend the subject 

below it into sharp focus. By focusing on 
these droplets so that the subject falls out of 
focus in the background, we can create a 
macro image that reveals a visually exciting 
combination of elements. Use a bright and 
colourful subject such as sweets, and you’re 
on to a winning formula.

For this technique, you need a macro lens 
or close-up filters, a reversing ring or 
extensions tubes to use on a standard lens. 
The latter is problematic though because of 
the extremely shallow depth-of-field 
extension tubes produce, even at medium 
to small apertures. Beyond this, you’ll need a 
tripod, an A4 sheet of Perspex or glass, a 
small plate, a sheet of white paper, a large 
bag of colourful, round sweets like Skittles 
and something to elevate the Perspex above 
the plate. A pipette is also extremely useful 
for creating the droplets, and you can either 
use water or glycerine to create them. 
Glycerine, pipettes and clear Perspex can be 
purchased inexpensively from eBay.

PH O
S



APERTURE TOO WIDE: In this
imagethesweets in thecentreofone
of theglycerinedrops issharp,but
with theapertureset to just f/2.8 the
depth-of-field issoshallowthatnot
eventhewholedroplet is in focus.
Thiscompletely ruins theeffectand
iswhytheapertureneedstobeset to
f/11 toensurethedropletsaresharp 
from the centre to the edge.

CAMERA SHAKE: When shooting
indoors, especially on hard floors,
and even when using a shutter
remote or self-timer to release the
shutter, camera shake can be a
problem because of how your
movements make the camera
vibrate. When releasing the remote
or waiting for the self-timer to finish, 
remain as still as possible.

Refractive still-life

26 Digital SLR Photography November 2020

1 ARRANGE THE SWEETS:Place a sheet of
white A4 paper on the floor with a small

plate on top in the centre. Pour your large
family-size bag of sweets onto the plate
and arrange them so that they’re suitably
mixed up and covering the central area of
the plate. The sheet of paper is used to stop
any minor colour casts in the shot being 
caused by the colour of the flooring.

2 RAISE THE PERSPEX:Find a way to support
the sheet of Perspex or glass roughly

20cm above the plate of sweets. Here,
I used Duplo bricks to create four pillars
– they make it quick and easy to adjust the
height, and they don’t block out the
essential window light. If you don’t have
access to Duplo bricks, you could use books 
or plastic tubs to support the Perspex.

4CAREFUL FOCUSING:With slow shutter speeds due to shooting
indoors with window light, you’ll need a tripod with an articulating

centre-column or to insert the centre-column upside down for a low
angle with the camera looking overhead. Attach the camera,
compose and focus the shot manually using LiveView magnified into 
one of the larger central droplets. 

3 PLACE THE DROPLETS:Whilst water does
work it’s much more prone to the

surface tension breaking and the droplets
becoming small puddles. Glycerine is a
much thicker liquid but behaves in a similar
way to water, but holds the surface tension.
The disadvantage is that if you make a mess
placing the drops, it’s harder to clean up.
Here, I carefully used a pipette to apply. 

5CAMERA SETTINGS:Set the camera to aperture-priority at f/11 with ISO
at 100. Even with this narrow aperture, the sweets in the background

will fall out of focus and the depth-of-field will maintain the sharpness
of most of the liquid drops. Set the self-timer to a five-second delay or
use a remote release to fire the shutter to help avoid any camera shake. 
Set White Balance to Daylight and use multi-zone metering.

6CONTROL EXPOSURE:Depending on the camera you have, turn on
the live histogram in LiveView, or if your camera doesn’t have this

functionality take a test shot and view the histogram of the reviewed
image. Use this to assess exposure and apply exposure compensation 
to lighten or darken the exposure as required. For this image, the
exposure compensation was increased from +0.3EV to +0.7EV.

SHARPNESS PROBLEMS



SWEET SUCCESS!
Withenoughdepth-of-field,careful

compositionandprecisefocusing,
this techniquecanworkatreat.

Exposure:0.5 seconds at f/11 (ISO 100)
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CAPTURE GHOSTS 
ON CAMERA

GET INTO THE SPIRIT OF HALLOWEEN WITH A LONG-EXPOSURE PORTRAIT TECHNIQUE 
THAT'S SURE TO GIVE YOU GOOSEBUMPS. CAROLINE SCHMIDT SHOWS YOU HOW…

CAMERA: NIKON D750/ LENS: SIGMA 35MM F/1.4 ART



Halloween portraits
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1 YOUR LOCATION:Choose an eerie spot with atmosphere such as a
derelict building or dark woodland – the darker the better as it will

make achieving long exposures easier and the 'ghosts' easier to see,
too. Whilst you do not need to shoot after dark for this technique to
work, we do recommend shooting as late in the day as you can and in
a dark location to control the ambient light. If conditions are still too
bright, you could use a solid ND filter or a polarising filter to artificially 
extend your exposure without causing images to overexpose.

3CAMERA SETTINGS:You need to control your shutter speed using
shutter-priority mode or manual mode. Dial in your lowest ISO

rating and a mid to small aperture; here I fluctuated between f/11 and
f/14. You’ll need a shutter speed of at least two seconds long but aim
for as long as possible to give your subject time to move during the
exposure. Lock focus on your subject using single-point AF or manual
focus. As you're using a tripod, a small aperture and your subject will 
be rendered translucent, focusing is the least of your concerns. 

2SET UP:Plan how you want your final image to look when styling
your model. For a black & white conversion you’ll need your

subject dressed in light or midtone-coloured clothes to contrast
against the dark background; floaty fabrics or period dress also add
to the effect. Almost any lens will work for this shoot but bear in mind
social distancing and while a wide-angle lens will give your subject
more scope for moving within the frame, you may need to shoot at a
closer range than a standard lens to avoid them looking too far away. 

4CAPTURE MOVEMENT:The speed and the direction in which your
subject moves as well as your shutter speed combined determines

the final result. If they move too fast or the exposure is too long, they
may not be recorded in the image at all; if they move across the frame,
you'll end up with streaks (see above); if they don't move enough or
the exposure is too short, they’ll be too visible. I found the best results
came from the subject moving towards the camera slowly, stopping 
completely intermittently before travelling forwards again.

A
LL HALLOWS’ EVE is not for the faint
of heart or to everyone's taste. Some
people like a big scare, the fun of
dressing up and trick or treating, or

embracing the darker side of photography
by shooting spooky portraits. For those that
find the October 31st ‘holiday’ offensive, we
do hope you see this technique in the spirit
it’s meant to be – a little bit of spooky fun for 
those who want to try it. 

Shooting effective Halloween portraits
does take more than a frightful costume and
low-key lighting, though, so it’s worth a go
if only to challenge your in-camera skills.
This particular technique, for instance, is
achieved completely in camera using a long
exposure and finished up on page 32 with
some enhancing – but not essential – post-
production. Your equipment list is short, too:
a tripod, camera and lens. A remote release 

can be useful when working with long
exposures and a solid ND filter can be
beneficial for controlling daylight as well.

The special effect does take some practice
and perseverance, and looks great in colour,
but if you want to know how to enhance the
effect with texture and an aged black & white
treatment be sure to turn the page. We've also
another spooky editing technique on page 34 
you won't want to miss. 



DON’T GIVE UP THE GHOST
Countingthesecondssothesubjectwalks
slowlyforone,stopsforone,walksforone

andthenstopsagainworkedwell.

Exposure:Three seconds at f/11 (ISO Lo 1.0)



3BE MORE PRECISE:Under the B&W tab, you’ll 
find a range of colour channels that allow 

you to isolate the tonality of that colour. For 
instance, by increasing Green and Yellow, 
the foliage lightens like you’d expect from an 
infrared image; Purple and Magenta target 
her dress; and Orange darkens her skin tones 
and adds some more shadow detail. Find the 
balance for your images.

6OPEN IN PHOTOSHOP:To add some texture
and framing, go to Photo>Edit In>(choose

software). Add your film textured layer over
the top of your portrait, using the Move Tool
to resize, and then change the Blend Mode
to either Lighten or Screen to fade the image. 
You may want to add a Layer Mask and use the 
Brush Tool to remove the texture from parts 
of the portrait, too.

Enhancethehorror!
CAROLINE SCHMIDTSHARES SOME OPTIONALTWEAKSTO MAKE
YOUR CHILLING HALLOWEEN PORTRAITEVEN CREEPIER

WHAT IS IT about 18th Century photographs that give us the creeps? For me,
it's the combination of their stern-looking faces, period dress and the
photo's aged appearance that makes old film portraits especially eerie. For

others it's because the people in the pictures are no longer alive but, whatever the
reason, weathered film photos done right are enough to give anyone goosebump

Whilst most of this editing is done in Lightroom Classic CC, the final step is in
Photoshop but can be done using almost any other software that has the capabilit
of Layers and Blend Modes, such as Affinity Photo or Photoshop Elements.
Lightroom has many superpowers but merging images, unless a HDR image, is not
of them and to apply texture you need to be able to blend. If you’ve got your expos
spot-on in-camera there’s probably very little for you to do to your image if you w
keep it in colour. But this tutorial will show you how to create an aged black & white
image and it works best if your subject is dressed in a contrasting tone to their
surroundings. For instance, here her blonde hair is a feature and the dusty pink dres
light enough to create some separation from the darker woodland.

TEXTURE Adobe Lightroom & Adobe Photoshop

ORIGINAL
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1OPENALLYOUR IMAGES:Pick your favourite 
images from the shoot and open them all 

in Lightroom to see how this treatment works 
differently depending on the image. You
only need to apply the steps to one image,
then select all the files and click Photo>Sync
Settings to apply the edits automatically to all
the images. Save them as copies so as not to 
overwrite the coloured versions.

4SPLIT-TONE:By split-toning the highlights 
and shadows, you can add a variable 

colour tint like sepia without it looking like
an overpowering wash of colour. To do this,
click on the colour swatch next to Highlights
to select your warm but muted tone (you can
also use the Hue slider to do this) and do the
same for the Shadows. The Balance slider 
gives weight to shadows or highlights.

2STARTWITHTHE BASICS:Start by clicking Black
& White (located next to Treatment) to turn 

the image monochrome. You'll still have the
colour channels to adjust but you'll be 'seeing'
in b&w. Next, visit the Basics tab where you’ll
find all the usual essentials such as Exposure,
Contrast and Highlights, so make what tweaks 
you need. Try reducing Clarity slightly to 
soften details and the 'ghost' further.

5ADD NOISEANDVIGNETTE:Film photographs 
used to be riddled with noise, artefacts and

often vignetting so it seems suitable to ‘dirty’
up our clean digital files. Under Effects, use
the Post-Crop Vignetting features to refine
the appearance – subtle and soft is often
best. Next, increase the Noise Amount slider 
but keep the size small. This will degrade the 
quality of your image but that’s okay here.



THAT’S THE SPIRIT!  
A quick and dirty black & white conversion 
will transform already creepy images into 

bone-chilling portraits this Halloween. 

TOP TIP
WherecanIgettexturesfrom?
Whilst you can shoot your own,  

a quick Google search will bring up 
lots of options for downloadable 
textures of all styles. This one was 

free to download from 
Lostandtaken.com 



3REFINE & BLUR:Switch to White paint to 
make corrections and adjust the size of 

the brush to target the details more precisely
around the feet. When finished, select all the
layers and go to Document>Flatten and then
Layer>Duplicate. With this new layer selected,
go to Filter>Blur>Depth Of Field Blur. This is 
optional but blurring the background more 
can help the subject to stand out. 

6TONING:A quick and easy way to adjust
the colours in an image is to use a Colour

Balance adjustment layer as you can target
the highlights, midtones and shadows
independently, then use the Mask to remove 
edits from the subject. Here, the Midtones 
were cooled by adding Blue and Green and 
Cyan to the Shadows, but it’s all removed 
from the subject to keep skin tone natural.

Rise totheoccasion
LEARN HOWTO SIMPLYLIFT YOUR SPIRITS WITH A TWO-SHOT 
BLENDTHATLEAVESTHEVIEWERWONDERING HOWIT'S DONE

L EVITATING TECHNIQUES ARE as old as
they are popular and they never seem to
fall out of favour, especially around All

Hallows' Eve. Creating the illusion of
something or someone floating off the
ground doesn’t need to appear haunting, it's
a versatile and magical technique that could
be applied to many a set-up from still-life to
superhero children's portraits. No matter 
your approach, the technique remains largely
unchanged – both in and out of camera. 
Essentially, you need two exposures: one of 
the subject elevated by a prop and the 
second is just a scene-setter with the prop 
and person removed – the consistent 
elements in both images will be the exposure 
settings, focusing and the camera’s position, 

which is why a tripod is vita
It’s then a case of overlayin
the frames and erasing the
to be replaced by the scen
setter. Sounds easy, and it
there are a few pointers tha
help make the image look
‘realistic’. Your prop, for inst
if you’re hanging objects, use a thin but
strong wire-like fishing line as it's easiest to
hide when editing. If you’re levitating a
person, you need to watch the position of
their feet as they’d naturally relax and point
downwards if floating. Here the subject was
positioned with her heels perched on a brick
to create the illusion, otherwise she would
have been hovering flat-footed. Similarly, 

if you’re wanting to lay the subject down flat
on a table make sure their clothing drapes
correctly to avoid any tell-tale flat edges
once the table has been edited out. Using a 
low shooting angle can help to emphasise 
the height of floating subjects, too, and 
locking focus manually with the same 
aperture on the same spot in all the frames 
will help with merging images later. 

UND IMAGE CARO
LINE SCHM

IDT

 Affinity Photo
SUBJECT IMAGE
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1OVERLAYYOUR IMAGES:Choose two images
– your scene-setter and your best shot of

the subject – open them both in your editing
software, which in this case is Affinity Photo.
Click on your portrait and then Edit>Copy,
then on the background image and click
Edit>Paste to put them in the same Layers
palette. If needed, click the Adjustments icon
and use Curves to improve the exposure.

4ADJUSTTHE BLUR:Use the anchor points
to position the central anchor over your

subject to isolate your point of sharpness.
Move the inner circle to target your focal
point and the outer circle to adjust the shape
and breadth of the blur. Set Elliptical blur and
adjust the Amount slider to increase softness. 
To preview the effect, select the split-screen 
icons at the bottom of the dialogue box. 

2ADDAMASK LAYER:Double-click on your
portrait layer and rename it to avoid

confusion, then click the Mask layer. Zoom
into the image so as to focus on the prop
and select the Paint Brush Tool. You want
to select Black paint and to do this, go to
Window>Studio>Colour. In the Options bar, 
select an appropriate size brush to carefully 
remove the prop elevating them. 

5CROP& POP:Use the Crop Tool to tighten
your composition, if needed, and then add

a Curves adjustment level and pull down the 
centre of the curve (the midtones) slightly
to darken the image. Being an Adjustment
Layer, you can then use the Paint Brush Tool
with Black paint to carefully remove this 
adjustment from the subject, helping them to 
‘pop’ from their surroundings.



TRICKS TO ELEVATE YOUR PHOTOS
Therearesomanywaysyoucanapplythis

techniquetoahugerangeof imagesthat
levitatingisayear-roundsourceoffun

once you know the tricks behind the shots.

SHOOTINGTIPS
Useatripod

Setthelenstomanualfocus
Keepthecamerasettings
thesameforallyourshots

Tryalowshootingangleto
exaggeratetheirheight

Avoidflatfeet:pointedtoes 
are the way to go



Seetheworld
throughtheireyes
ASIMPLE IMAGEWITHAPOWERFUL
UNDERTONEGIVENTHE CURRENT
STATEOFAFFAIRS.CAROLINE SCHMIDT
SHOWSYOUHOWTO RECREATEIT

W ITH CHILDREN HAVING gone back
to school after five months of turmoil
and uncertainty, into their new

‘normal’ classroom activities, new rules and
social distancing from friends, it’s not a simple
life our children lead. They see so much, hear
so much and understand not quite as much
but their bravery, resilience and adaptability
over recent months should not be
undervalued. For those of us who are parents
or grandparents, these mini-adults have
probably been one of our biggest concerns
during the pandemic and that’s why this
technique rang so true and topical.

To literally see the world through their eyes,
you need to first photograph their eye and
that’s simple. Use a macro lens so you can fill
the image area as much as possible with the
section of their face (for this image, a 100mm
macro lens was used) and select single-point

AF to focus on their pupil, be careful not to
focus on their eye lashes as depth-of-field
will be shallow. Having them face a window is
the easiest lighting option, but if you want
clean catchlights consider using a studio
set-up. Set aperture-priority mode and a
mid-aperture depending on what you want
in focus – here I used f/4 as I just wanted the

OVERLAY IMAGE

ORIGINAL IMAGE
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 Adobe Photoshop CC
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eye to be sharp and the nose soft so as not to
distract the viewer. Take a few frames as you 
want their eyes to be sufficiently open to see 
as much of the iris as possible, but without 
them looking like a deer in headlights – it
may take a few tries to strike the balance.

Once you have some options, pop on to
the NASA.gov image library and download 
one of the blue marble photos that have 
minimal cloud coverage – most images 
permit for personal and instructional use  
(not commercial) but check the specific 
usage rights. You’re now ready to go. 

1 RETOUCHYOUR PORTRAIT:Begin by editing 
your portrait; having used a macro lens, all 

the tiny blemishes and pores will be visible. 
It’s another reason why frontal lighting 
is preferred, especially if you’re working
with teens who might have pimples, as
side-lighting can be unforgiving. Add a new
empty layer to your Layer’s palette and use a
combination of the Clone Stamp Tool and the
Healing Brush Tool to even out the skin tone
and remove obvious marks. Make sure in the
Options bar, Sample is set to All Layers, too.
You might also like to use the Brush Tool, with
a very low Opacity, to sample an area of skin
near the undereye (click alt to sample) and to 
even out any undereye bags.

3REFINETHE SELECTION:Back in the main body
of Photoshop, you should see marching

ants around your selected background. Go to
Select>Inverse. At the bottom of the Layer’s
palette, click Create a new layer, then on the
selection go to Edit>Copy. Click back on to
the empty layer and go to Edit>Paste. You
can click the eye icon next to the Background
layer to turn the original image off, allowing
you to preview the selection. Here there’s
a dark rim from pulling the Fuzziness slider
down too far, which in effect feathers the
edges, but I’m not concerned as it’s minimal
and can be removed in step 5. Save your new
world selection. Then click Edit>Copy, click 
onto your portrait and then Edit>Paste. 

2SELECTTHEWORLD:Open your image of the
Earth in Photoshop. Generally, NASA’s 

images are against a black background (a 
benefit of shooting into space) so selecting
the globe should be fairly easy and there are
a number of ways you can do it. The Lasso
Tool and Quick Selection Tool along with the
Select and Mask function are options but here
we try Color Range (Select>Color Range).
Use Sampled Colors and select Selection so 
you can see the coloured background, you’ll
see your selection in real-time on your main
image too. Increase the Range slider towards
100% but reduce the Fuzziness slider to
around 50% once you think you’ve selected all
the grey areas in the background. Click OK. 



https://avxlive.icu/


https://avxlive.icu/


IT’S ALL IN THE EYES
You’realmostdone.Cropping 
can tighten the composition and 
accentuate the focus on the eye, 
but this is down to personal taste. 
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5REFINEYOUR EYE:You might still have some
visibly hard edges or areas around the iris

that don’t blend perfectly with the world, but
there’s an easy fix. With the world layer still
selected, click the Add Vector/Layer Mask
button the bottom of the Layers palette.
Select the Brush Tool and set the Foreground
Color to Black, then zoom into the eye 400%
by clicking cmd and + (Mac)/ ctrl and + (PC).
The properties of the Brush Tool should be
a mid-opacity and 0% Hardness to keep the
edges soft. Now slowly and carefully remove
any overlapping areas of the world on the eye
lids and whites of the eye. You may even want
to lightly brush over the catchlights to make
the effect look more realistic.

6TONALADJUSTMENTS:Right now, the
contrast and high saturation of the world, 

which is a side effect of the Overlay blend
mode, jars with the low-contrast skin tone. 
To increase the contrast and depth of the face 
without increasing the colour saturation, add
a Black & White adjustment layer either by
clicking on the Create new fill or adjustment
layer icon at the bottom of the Layers palette
or going to Layer>New Adjustment Layer>
Black & White. Change that layer’s Blend
Mode to Soft Light. The effect will be very
strong so pull back the layer’s Opacity slider to
about 50% to reintroduce softness. Using the
Brush Tool on the Adjustment Layer’s Layer 
Mask, remove the effect from the eye. 

4ADJUSTTHEWORLD:With the Earth now on
your portrait, use the Move Tool with the

Shift key pressed to resize it proportional to
the eye. Reducing the layer’s Opacity slider
to 70% can help you to see the outline of the
eye more easily. Next go to Edit>Transform>
Warp and manipulate the shape of the planet 
to fit within the edges of the iris. By doing 
this, you get to keep more of the image in
the eye as opposed to losing it under the eye
lid. Before you click the Tick to commit to
your transform command, change the Blend
Mode of your world layer to Overlay so you 
can refine any warping. You want to try to do 
all transform commands at once as they’re 
nondestructive until you commit to them. 





EVER MISUNDERSTANDTHE MEANING OF OPEN UPAND PPI, ORARE UNSUREWHAT TERMS LIKE
RESAMPLINGAND SELECTIVE FOCUS RELATETO?THEWORLD OF PHOTOGRAPHYIS RIFEWITH

ACRONYMS,ABBREVIATIONSANDTECHNICALITIESTHATCAN MAKE UNDERSTANDINGALLITSTERMS
DIFFICULTATBEST. EVERYMONTH INTHIS SERIES,WE’LLBE BUSTINGTHEJARGON FORALLTHE MOST

COMMONTERMS IN OUR PHOTOGRAPHYDICTIONARY. THIS MONTHWE COVER O-S

TO
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is for...O

OVEREXPOSURE: 'Blown-out' highlights, white-washed midtones and no sign of
shadows is a good indication that your image is overexposed. It happens when the
exposure value is higher than it should be causing too much light to be recorded and 
detail being lost in the highlights, as it falls outside of the sensor's dynamic range.
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OPEN UP: When told to 'open up', it most commonly means to set your aperture to a larger
f/stop for a shallower depth-of-field and brighter exposure, such as switching from f/4 to f/2.8.
It is the opposite to closing or stopping down your lens, which is when you select a smaller
aperture to reduce the amount of light passing through and to increase depth-of-field.

OLED: An OLED (Organic Light
Emitting Diode) microdisplay is used
in mirrorless cameras as electronic
viewfinders and differ from a standard
LED display. An OLED does not require
a backlight and provides higher
contrast. It uses red, green and blue
LEDs unlike LCD screens which useLEDs unlike LCD screens, which use 
coloured filters on a backlight.

OOF (OUT OF FOCUS):
While it can refer to areas of shallow
depth-of-field OOF usually meansdepth of field, OOF usually means
you have not focused correctly.
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O is for Optical...
 OPTICAL VIEWFINDER:  

It's an oldie but goodie, the optical 
viewfinder is the traditional but still a 
beloved way of composing 
photographs. When you’re looking 
through an optical viewfinder you’re 
seeing the scene as it's reflected off 
your camera’s mirror and flipped the 
right way up by its prism. Even though 
most DSLRs feature LiveView, optical 
viewfinders remain popular. Mirrorless 
cameras offer electronic viewfinders.

 OPTICAL ZOOM: Otherwise 
known as a zoom lens or parfocal 
lens, this type of optic changes the 
magnification ratio as you adjust the 
focal length. You can adjust your focal 
length by turning the ring on the lens 
barrel. After zooming, always be sure 
to focus. DSLRs use optical zooms but 
camera phones, bridge and compact 
cameras use digital zooms.

 OPTICAL RESOLUTION:  
The resolution at which a sensor 
captures an image and indicates the 
level of detail it is able to record. 



is for...

PIN-CUSHIONING: A type of
distortion that can make images
appear pinched, pin-cushioning is
mostly witnessed in cheap telephoto
zoom lenses but can be corrected
during editing. It's opposite is barrel
distortion which causes an image todistortion, which causes an image to
bow outwards from the centre. 
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Program mode
Program AE is one of a

camera’s fully-automatic exposure
modes, indicated on the exposure

dial as P. In program mode, the camera
decides on the shutter speed and
aperture combination but, unlike

Full Auto mode, the user can affect
the exposure by adjusting the

ISO rating or by setting
exposure compensation. 

PROOF: A print proof is an early
version of an artwork prior to
production to check for accuracy and
to assess what the final print will look
like. Photographers often provide a set
of proofs to clients as part of their
selling process to help clients to select
their images before products are
produced. These proofs can be
tangible or digital, viewable via an
online gallery or as downloads, but
either way almost always feature a
semi-transparent watermark tosemi transparent watermark to
protect the copyright.

PICTBRIDGE: PictBridge is the
industry standard that allows you to
print directly from a digital camera to a
printer if both the camera and printerprinter if both the camera and printer 
are PictBridge-compatible.

P

PAINTING WITH LIGHT: As a creative lighting technique, painting with light is broad 
and brilliant for almost any subject matter. By combining a long exposure with a 
continuous light source, such as a torch, strip lights or light-painting brushes, you can 
'paint' your subject with light for the duration of the exposure, gradually building up its 
luminosity for a soft quality of light. It’s a technique best used when there’s no, or very 
little, ambient light that could affect the overall exposure. It’s a popular approach for 
illuminating foreground interest for star trails or images of the Milky Way. 
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PRIME LENSES: Lenses with a fixed focal
length are known as prime lenses. They do
not offer a variable focal length, unlike a
zoom lens, so to change your subject’s
magnification or composition you must
physically move closer or farther away.
Most primes lenses are also ‘fast’ lenses that
feature maximum apertures of f/2.8 or wider,
others start at f/4, and are generally
exceptionally sharp. A popular entry-level
prime is the 50mm f/1.8 but primes can go
as wide as 20mm and as long as 600mm.
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PHOTOSHOPPED: Like so many 
well-known brands that become the 
archetype of a product or technique, 
Adobe Photoshop is that for editing. 
Despite a plethora of highly capable 
alternative editing software available, 
Photoshop is still considered the gold-
standard for professional editing. 
When you hear the term it’s been 
‘photoshopped’ they often mean it’s 
been heavily retouched or digitally 
manipulated to look the way it does. 

PANCAKE LENS: It’s a colloquial term for
any lens that’s shorter than it is wide. They’re
usually prime lenses and much smaller and
lighter than a standard lens. Offering
excellent value for money, pancake lenses
boast a fast, maximum aperture and suit a
variety of subject matter. Good examples are 
a Canon 40mm f/2.8 STM, Nikon 50mm
f/1.8D and Sony 35mm f/2.8.

is for...P

PHOTOBOMB: That annoying but
humorous person (or animal) who
deliberately or unintentionally enters
the frame of your carefully-composed
photograph the moment you fire thephotograph the moment you fire the
shutter is your 'photobomber'.

PIXELS AND PPI: Pixels are known
as picture elements and are the
smallest components of a digital
image – little squares of colour that
become visible if you zoom into them.
A camera’s resolution indicates the
number of these pixels on an imaging
sensor and therefore in the pictures
you capture. Typically, the higher the
pixel count, the higher the image
quality. Pixel density is measured by
PPI (Pixels Per Inch). A 300ppi image is 
hi h li h 72 i ihigher quality than a 72ppi image.

Greats of photography

Martin Parr (1952-present)

A British documentary photographer,
Parr is best known for his satirical and
anthropological look at British life. He
focuses on leisure, consumption and
communication as he examines our

country's national characteristics.

Irving Penn (1917-2009)

An American photographer considered to
be one of the greats of the 20th Century.

While Penn is celebrated as a Vogue
photographer for more than 60 years,

he's also known for revolutionising
still-life photography for the advertising

industry and pioneering platinum printing.
Before his death, he established The 

Irving Penn Foundation.
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PIXELISATION: The deterioration
of a low-resolution image caused by
a lack of pixels, resulting in individual
pixels becoming visible and therefore
image quality appearing low. Printing
an image at a low DPI will result in the
image becoming pixelated, as can
dramatically enlarging an image.
Pixelisation is often used, however,
to censor images so that details in ato censor images so that details in a 
picture are obscured.

PERSPECTIVE: By controlling
perspective, you can create a sense of
depth in 2D images by making subjects
appear larger or smaller, nearer or farther,
than they actually are. You can control
perspective through your lens choice,
shooting angle and shooting distance.
Wide-angle lenses, for instance, are
known for elongating perspective, which
can enhance the appearance of depth
– great for landscapes, buildings and for
utilising converging verticals, but not for
most portraits. These benefit from a
telephoto's foreshortening or a 50mm's
more natural perspective. A tilt-shift lens
is known as a perspective-control lens as
it allows you to tilt the angle of the
optical path relative to the sensor. By
tilting the lens, you can get greater
control over depth-of-field whilst the
shift function allows you to counteract
the convergence of straight lines.
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PORTRAIT: The art of portraiture in 
photography dates back to the 19th 
Century and involves posing people in 
front of a scene or plain backdrop 
before working to capture their true 
likeness. Anyone can take a shot of a 
person but it takes skill to create a 
portrait. You need to understand 
colour, skin tone, lighting, exposure, 
perspective, depth-of-field and not to 
mention post-production. Portraits 
are known to tell the truth but also lie, 
all depending on the approach, style 
and intention of the photographer.

Panning
To capture a moving

subject sharply whilst rendering the
background full of motion blur you need

to practise panning. It's a tricky technique to
master but worth spending the time on; you

need to swivel the camera horizontally in line with
the subject’s movement, while using shutter-priority

mode with a slow shutter speed – how slow
depends on the speed of your subject. For instance,
you need a faster shutter speed for a race car than
you will a cyclist. Use continuous shooting mode

and steady yourself to minimise any tilting of
the camera, then shoot as you swivel from

the hips with your arms locked to your
side as you track the subject

across the frame. 
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POINT AND SHOOT: A term often
used for fully automated cameras
needing little intervention from a user.
Typically associated with compact
cameras or entry-level DSLRs set to
Full Auto mode, all the user needs to
do is compose the image and press
the shutter button the camerathe shutter button – the camera
computes the rest of the settings. 

PSD FILE: Like JPEG and TIFF, PSD is
a file format but is native to Photoshop
and stands for Photoshop Document.
Photographs edited in Photoshop
usually comprise Layers that influence
the look of the final image. When
saved as a JPEG, the image Layers and
the edits are lost during compression.
By saving a version of the image as a
.PSD file, you save all the Layer
content and selections you’ve made
so you can return to it at a later date.
The drawback is that PSD files can
reach several megabytes if notreach several megabytes, if not
gigabytes in size. 

POLARISING FILTERS: When light reflects off non-metallic surfaces like water it 
causes glare, which can reduce contrast, desaturate colour and interfere with reflections.
A circular polarising filter attaches to a lens's filter thread and can be rotated to vary the 
strength of absorbed polarised light to eliminate glare, control reflections and saturate 
colours. Polarising filters are best used approximately 90° to the sun and are dense 
enough to absorb up to two stops of light, meaning they also extend exposures. It’s 
considered an essential piece of kit if photographing woodlands, water or blue skies as 
the effect cannot be replicated in post-production. As polarisation is affected by your 
shooting position, wide-angle lenses can reveal areas of uneven polarisation. 
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PANORAMA: When you simply can’t squeeze an epic scene into a single frame, or you get too
much edge distortion from your ultra wide-angle lens, your best approach is a panorama. You
can elongate your field-of-view as wide as you like, even 360°, with this approach, vertically
and horizontally if you wish. With your camera secured to a tripod, and ideally using a head with
a panoramic action for smooth and level movements, you take a series of frames ensuring
they’re overlapped to aid stitching the shots together in post-production. Sometimes, to get
the best from your panorama, you need to shoot long and many rather than wide and few, in
other words exchange your ultra wide-angle lens for a long lens. By using a telephoto lens, you
expand your field-of-view but without the distortion from a wide-angle lens. Panoramas are
commonly created to accommodate sweeping landscapes, cityscapes and architecture.

POCKETWIZARD: A brand of
radio slave used for off-
camera flash photography,
PocketWizards were so
popular that it became
synonymous with the
product genre. The slaves
allow a flash to be fired
remotely by attaching a
radio transmitter to the
camera’s hotshoe and a
receiver to the off-camera
flash or studioflash. It was one of
the first brands to integrate TTL metering
and can be fired from several hundred
metres apart, making them popular to use
on location. PocketWizards are still deemed
the gold standard by professionals but there
are a number of cheaper brands, such as
Yonguno, that have emerged with similar
specifications but priced for the masses.

is for...P
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RGB: Red, green and blue are the
three primary colours of light and the
channels that make up the RGB
colour gamut, as when mixed can
produce a broad array of colours.
Most cameras and editing profiles
begin as RGB, but you can change it to
Adobe RGB or sRGB for wider gamuts
or CMYK, standing for Cyan, Magenta,
Yellow and Black, which are the
primary colours of pigment and usedprimary colours of pigment and used 
for printing images.

REFLECTOR: A reflector is a lighting
modifier that does what it says on the tin
but that tin can come in various shapes,
sizes and types. Essentially any reflective
material that bounces light onto a subject
to fill in shadows is a ‘reflector, such as
stainless steel, glass, concrete, tin foil or a
white piece of paper. Reflectors are the
most popular type of lighting aid and
comprise reflective material stretched over 
a frame. These types of reflectors come in
many sizes, some need a stand while others
can be handheld. There are three main
finishes that affect the strength, warmth
and quality of the reflected light: white,
silver and metal-effect (e.g Sunfire). There
are plenty of choices to suit all budgets,
which is why they’re such popular 
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Rule-of-thirds
A core compositional device that
involves dividing a scene into a

three-column grid horizontally and
vertically, which in turn creates four

power points on which to place your focal
point. It’s a guideline that helps to compose

off-centre subjects in a visually pleasing
way. Many DSLRs feature an optional
overlay of the rule-of-thirds to help

with composing images using
the LCD monitor. 

RESIZE: To resize your images means
to either change the dimensions or
size. You can do this by accessing
Image Size in your chosen editing
software, although this should be
done carefully so not to affect image
quality (see resampling) or you can
use the Crop Tool to change youruse the Crop Tool to change your
aspect ratio e.g from 8x10in to 8x8in. 

RIG: A camera rig is a piece of
equipment that helps to stabilise your
camera so you can capture seemingly
impossible images. Rigs are often
used for action photography to secureused for action photography to secure
and stabilise a camera to a moving car. 

R RANGEFINDER CAMERA: It's not just 
its good looks but its focusing mechanism 
that makes a rangefinder so special. It 
works by overlaying a 'ghost' image of the 
scene, which when you turn the focusing 
ring brings the two images into alignment 
for a sharp shot. Some rangefinders are 
built-in, some sit in the hotshoe and 
others are coupled to the focusing 
mechanism. They first appeared in the 
early part of the 20th Century and grew in 
popularity during the 1930s to 1970s, but 
fell out of favour with the dawn of 
single-lens reflex cameras (SLRs). Their 
attractive style have been adopted by 
some mirrorless cameras by the likes of 
Fujifilm with its X-Pro series and with 
Leica’s digital rangefinder cameras.
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RESAMPLING: It’s the process of
adding and removing pixels during
post-production – you can upsample
(add pixels) or downsample (remove
pixels), which ultimately affects the file
size and the number of pixels and
detail. It’s not a simple process without
aaffffecting image quality and requiresecting image quality and requires 
an algorithm to do it correctly.

RETOUCHING: When you hear
'retouching', you think portraits but
retouching is actually an umbrella
term that encompasses any editing
post-capture, from removing dust
and dirt from an image, unsightly
objects or people from landscapes to
polishing portraits that grace the pages 
of magazines and advertisements.
Retouching is an artform in itself,
taking skill and practice to do well,
but is of equal importance to the artbut is of equal importance to the art
of digital photography these days. 

RESOLUTION: The resolution of
your stills and video indicates the
number of pixels (points of colour)
that make up your images. Full HD
resolution is typically 1080p and print
resolution is 300 to 600dpi (dots per
inch) – the bigger the print, the higher
the print resolution needs to be.
Higher resolution images mean moreHigher resolution images mean more 
detail per inch of image space.

RED-EYE EFFECT: When pupils
render red in photographs it's because
a burst of direct flash is reflecting light
off the retina and back down the lens.
It’s usually only an issue if the flash is
too close to the lens, such as with a
DSLR’s built-in flash or a compact
camera. You can get around it by
having the subject not look at the
camera, by attaching a flashgun to put
distance between the lens and the
light increasing the ambient light orlight, increasing the ambient light or
using red-eye removal when editing.

RENDERING: The term render, or
the process of rendering, refers to the
processing of image information as it
become viewable. When you apply
edits in post-production you wait to
see the results after it renders. With
mirrorless cameras, the information
from the imaging sensor needs to be
rendered in the electronic viewfinderrendered in the electronic viewfinder
or LCD monitor before you can see it.
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RAW FORMAT: Think of Raw files as digital negatives – it's a ‘raw’ unedited image 
format containing the maximum data your camera can capture but is unrefined and not 
print-ready. They’re unsharpened and unprocessed, unlike JPEGs, which is your job to 
do using Raw conversion software such as Affinity Photo or Adobe Camera Raw. It’s the 
only file format that provides images containing the full power of your camera in terms of 
detail, image size and dynamic range. These uncompressed images let you recover tonal 
detail, change White Balance and make exposure changes post-capture without 
damaging image quality – something that’s impossible to do with other file types. Every 
manufacturer has their own file extensions: Nikon has NEF, Canon CR2 and Sony has 
ARW, etc but you can convert these to a universal lossless file type called DNG.

R is for...

REMOTE CAPTURES: When you operate your camera’s shutter remotely, without
physically depressing the shutter button, this is called a remote capture. You can do this
using a wireless remote release, cable release or even a smartphone app via a Wi-Fi
connection, such as Nikon’s Snapbridge or Canon’s Camera Connect. It’s an invaluable 
tool when you want to be away from your camera, such as during wildlife photography,
long exposures or in low light, when the press of the shutter button is enough to
introduce camera shake. A wireless camera remote release works via a transmitter and 
receiver attached but some use an infrared beam, while other use a radio frequency.
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RACKING FOCUS: If you ever shoot
video with your DSLR you’ve probably
tried to ‘rack’ focus. It’s when you play
with depth-of-field by changing the
focusing plane during a continuous
shot to focus on something beyondshot to focus on something beyond 
the initial point of focus. 

REMBRANDT LIGHTING: A classic and
dramatic lighting technique taken from the
Dutch painter Rembrandt. Based on a single-
light set-up and short-lighting technique,
the key light is set up approximately 45° to
the subject’s nose. The key to recognising
you’ve achieved the Rembrandt lighting is
the triangle of light that becomes visible
under the eye farthest from the key light. 
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Ringlights
There are two main types of ring

light. Both are designed to give even,
shadowless illumination, but are very

different in design. A ringflash surrounds
the barrel of a lens and is used primarily in
macro photography. An LED ringlight uses

several small LED lights to provide a
continuous light source. There are smaller

versions that provide an alternative to
using a ringflash, while much larger

versions are available for use in
portrait photography.

Greats of photography

Rankin (1966–present)

John Rankin, who works under the name
Rankin, is a British portrait and fashion

photographer and now filmmaker. He’s
best known as a founder of Dazed and
Confused magazine, photographingd

Queen Elizabeth II, models such as Kate
Moss and celebrities such as Madonna. 

Man Ray (1890–1976)y

An American visual artist who contributed to
the Dada and Surrealist movements. He was
the first person to experiment with camera-
less photography and is well known for his 

photograms, dubbed rayographs.

RIM LIGHT: When a subject is backlit 
by the sun or flash, creating a halo 
effect, this is rim lighting. Sometimes 
the subject is exposed to shadow and 
rendered a silhouette against this rim 
light, other times it’s combined with a 
fill light to open up those shadows. It’s 
commonly used to separate a dark 
subject from a dark background. 
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SELF-TIMER MODE: No remote, no
problem. One feature nearly every camera
has is a self-timer facility that lets you fire a
camera hands-free. Sometimes it's buried
within a camera’s menu system, sometimes
it's accessible via the main body, but nearly
all cameras let you select a delay such as five
or ten seconds as well as specify the number
of frames you want it to fire. To trigger the
self-timer, you compose and focus your
shot then press the shutter button, which
initiates the timer countdown.
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SOFT-FOCUS LENS: This is not the
same as an image being out of focus.
Soft focus is a lens flaw and happens
when images become blurred due to
spherical aberrations. A soft-focus
lens deliberately introduces such flaws
to blur details whilst retaining sharp
edges. Think 1940s Hollywood
glamour portraits that don a dreamlike
soft-focus haze, designed to hide
blemishes. You can try to replicate the
look with an optical soft-focus filter.

is r...S

STEPPING MOTOR: Usually seen as
the abbreviation STM on certain
lenses, a stepping motor is a simple
mechanical structure that allows a
lens to operate quietly, smoothly and
quickly. It converts digital pulses into
mechanical rotation and a large
number of pulses will rotate the lens
fully and smoothly. It’s beneficial for
video shooting when operational
noise needs to be minimal. 
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SATURATION: Colour saturation is
indicative of how vibrant and intense
colours are – it is one of three
elements along with hue and value.
Unsaturated colours can appear grey
if they are reduced too much.

SNAPSHOT: A mindless press of the
shutter with little consideration for
composition, creativity or control over
camera settings. Snapshot is usually
the byproduct of 'point and shoot'.

STROBIST: Originating from a blog
by David Hobby (strobist.com), the
term 'Strobist' is now used as a name
for photographers who use off-
camera flash regularly and creatively.

48Digital SLR Photography November 2020

SILENT WAVE MOTOR (SWM):
Nikon lenses with its sonic AF system feature
this motor, providing it with high-speed,
ultra-quiet autofocus, which can be
identified by the letter ‘S’ (e.g AF-S). It’s
particularly beneficial in super telephoto
lenses where autofocus speed, accuracy and
low noise are important, such as with wildlife
photography. Canon’s equivalent to SWM is
its USM (Ultrasonic Motor); Sony’s is Hyper
Sonic Motor (HSM); and Tamron is Ultra
Silent Drive (USD), for instance, and all work
on the same principle of vibrating metal
rings. Nikon has also introduced AF-P, which 
stands for pulse and is even quieter and
smoother than AF-S and intended for
shooting video (see 'stepping motor' below). 
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SOFTBOX: One of the most popular 
lighting modifiers for portraits and 
still-life alike, a softbox comes in all 
shapes and sizes to fit off-camera 
flash or studioflash, but essentially 
have the same purpose of softening 
the output and giving a smooth 
gradient between light and shadow.  
Before reaching the subject, it 
bounces the light off its internal 
reflective surface before diffusing it
through a semi-transparent material
for an even, soft quality of light. As a 
rule-of-thumb, choose a softbox 
that’s a similar size to the subject 
you’re photographing, for instance for 
a headshot you might benefit from a 
softbox in the region of 18 to 24in; for
full-body portraits you might need to
use multiple softboxes. As a sub-
species of square softboxes you’ve 
also got stripboxes and octoboxes. 

Street 
photography 

Simply put, street photography is the 
visual documentation of everyday life and 

unsuspecting humans. It’s a form of candid
photography that generally occurs in public

places and taken of unaware strangers. Good 
street photography is engaging, crafted using 
environmental factors to aid composition and 
often plays with light and shadow beautifully

– they’re not mere snapshots, but portraits with
purpose. The discreet technique of shooting 

from the hip is commonly used in street 
photography, as are small mirrorless 

cameras, in order to stay 
invisible to subjects. 

 RAZVAN CHISU/UNSPLASH

 ZHU LIANG
/UNSPLASH

SHUTTER SPEED: It’s the setting 
that controls your exposure time and 
is one of three core features in the
exposure triangle to influence your
overall exposure. Your shutter speed 
determines how long your shutter 
remains open, which combined with 
your aperture helps determines how 
much light reaches the camera’s 
sensor. Shutter speed is measured in 
fractions of a second such as 1/30sec 
and 1/100sec until you reach whole 
seconds in length. If you want to 
freeze motion, you need to choose a 
shutter speed that’s fast enough to 
stop it in its tracks so as to sharply 
record the subject, for instance a 
person walking might need 1/125 to 
1/150sec but an animal running or a 
bird in flight might need up to 
1/2000sec to eliminate movement. 
Your shutter speed can introduce the 
appearance of movement, too, such 
as dragging the shutter to capture 
moving cars as streaks of light, blurring
a receding tide or panning a moving
subject. The slower the shutter speed, 
the more light that’s allowed into the 
lens; the faster the shutter speed, the 
less light reaches the sensor, so your
exposure has to be carefully balanced
with your aperture and ISO rating to 
ensure a correctly exposed image. 

Most cameras enable you to adjust 
your shutter speed in one-third, 
one-half and full-stop increments.  
For instance, 1/30sec to 1/60sec is a 
full stop as the shutter speed 
approximately halves, as does 
1/125sec to 1/250sec and 1/250sec to 
1/500sec. Between these full stops are 
half stops, such as 1/45sec, 1/180sec 
and 1/350sec but more commonly 
seen are 1/3 stops such as 1/30sec, 
1/40sec, 1/50sec, 1/60sec, 1/80sec, 
1/100sec, 1/125sec, 1/180sec, 
1/200sec,1/250sec, 1/320sec, 
1/400sec, 1/500sec and so on. 

Most cameras feature shutter 
speeds as fast as 1/4000sec – some 
as fast as 1/8000sec – and as slow as
30 seconds. Some also feature a Bulb
or Time mode, which allows you to 
manually control exposures longer 
than 30 seconds. Without a tripod,
your shutter speed should not exceed
your focal length. For instance, if 
shooting with a 50mm, your shutter 
speed should stay above 1/50sec to 
avoid introducing camera shake;
200mm, 1/200sec; 500mm, 1/500sec
and so on – it's the Reciprocal Rule.
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SELECTIVE FOCUS: A simple yet creative technique well worth the time to perfect if 
you enjoy using shallow depth-of-field, selective focusing (or differential focusing) is 
when you bypass the camera's preference to focus on what's closest to the lens by 
specifying your area of focus anywhere within the frame. By using single-point AF with 
your camera’s four-way control, or focus-lock, you can isolate your focal point and 
throw everything else out of focus. It’s ideal if you want to highlight a subject in the 
middle-ground and to shoot past foreground interest. It can be applied to pretty much 
any subject but is most popular with still-life, macro and portraits. 
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STAR TRAILS: As the Earth continuously rotates on its axis, when you use a long exposure to
photograph stars you won't capture stars but rather their trails as they rotate around Polaris. As 
the camera cannot track the movement of stars without specialist equipment, it stays static as
the hours pass by and the stars move in an arc. To capture their trails, you need to use Bulb
mode with an exposure between 30 minutes and three-hours long. You can use shorter
exposures of 30 seconds in shutter-priority mode but you’d need to shoot tens if not hundreds
of images using an intervalometer to be stacked in editing software such as StarStaX.

SEPIA: A warm, monochrome tint
that gives images an aged look. In film
photography, sepia was the product
of print toning a black & white image
for warmth. Some photographers still 
like to recreate the duotoned tintlike to recreate the duotoned tint 
digitally in post-production. 

SD/SDHC/SDXC CARDS:
These memory cards are
small but mighty flash
storage devices and are
capable of keeping up to
2TB of data. SD (Secure
Digital) cards have a fairly
low capacity of 128MB
to 2GB, which is not
particularly suitable for
the giant file sizes
produced by recent DSLR
SDHC versions are higher capacity
alternatives offering from 4GB to
32GB. SDXC stands for SD Extended
Capacity, which range from 64GB to
2TB. Some more expensive DSLRs
offer two SD card slots to increase the
amoun of storage. Take note of their
read/write speeds, too, as you’ll want
the fastest cards possible if you’re
shooting a high volume of images in
burst mode, such as with sports or
wildlife, to avoid images bottle-
necking in the camera's buffer
memory as you wait for them to write

dto your memory card.

is r...S

Greats of photography

Sebastião Salgado (1944-present)

A Brazilian photographer, Salgado is one of
the most widely respected and celebrated
social documentary photographers of all

time. His images are beautiful and yet laden
with political purpose, exposing the social
and environmental issues on our planet.

Cindy Sherman (1954-present)

She’s an American feminist photographer
and filmmaker who’s renowned in the art
world for her self-portraits that critique

gender and identity. She’s famous for using
her own body in her work and often

addressing issues like sexual stereotypes.

Harvey Stein (1941-present)

Currently a teacher at the International
Center of Photography in New York, Stein is
a documentary photographer, curator and

lecturer with countless exhibitions under his
belt – 86 one-person and more than 165
group shows across America and Europe. 
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SLOW-SYNC FLASH: Otherwise known as rear-curtain sync, with this flash mode
you’re telling the camera to fire the flash during a long exposure. In effect, you’ll
momentarily freeze a subject sharp with flash and then the slow shutter speed will gather
the ambient light so to better balance with the flash exposure. This often means
recording motion blur in the background too. You often have two options: rear-curtain
sync and front-curtain sync, which sets the flash to fire at the end or start of the
exposure, respectively. If there’s movement in the scene, use rear-curtain sync as motion
blur travels behind the subject instead of in front, which appears more natural.
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SCREW-IN FILTER: A cheaper alternative
to a slot-in filter system but the least versatile
of the two, screw-in filters – as they sound
– screw onto the front of a lens. As a result,
you may need to buy the same filter type,
such as a polarising filter, multiple times to
fit the different filter threads of your lenses.
A slot-in system, on the other hand, means
you buy one type of filter and use adaptor
rings to fit the filter holder to various lenses.
There are a few uses that are best suited to
a screw-in design, for instance a UV filter is
often used to permanently protect the front
element of a lens and circular polarisers can
be rotated to vary polarisation. LEE filters,
Hoya and Marumi are some of the most 
popular brands to produce screw-in filters.

S is for Shutter...
 SHUTTER CURTAIN: Whether 

film or digital, cameras have two 
mechanical shutter curtains – a front 
and a rear – that opens to allow light 
in and closes to block light out, in 
effect beginning and ending the 
exposure. Many cameras now feature 
an electronic front-curtain shutter 
(EFCS), designed to eliminate camera 
shake from the shutter mechanism 
opening, known as shutter shock. 
Shutter shock is more obvious in 
higher resolution cameras. With EFCS, 
the front curtain is opened but the 
exposure is then started electronically 
and ended mechanically with the 
rear-curtain shutter to reduce the risk 
of camera shake from the shutter 
opening at the start of the exposure.

 SHUTTER-PRIORITY MODE: 
Shown on your exposure mode dial as 
S or Tv, shutter-priority mode 
prioritises your shutter speed over 
your aperture. It’s a semi-automatic 
exposure mode that lets you set the 
shutter speed and ISO but the camera 
sets the aperture, meaning you do not 
have control over depth-of-field. It’s 
the best mode, next to manual, when 
movement is a priority, whether that’s 
freezing a moving subject or capturing 
a long exposure image.

 SHUTTER LAG: The time between 
you pressing the shutter button and 
the camera opening the shutter is 
called the shutter lag or shutter delay. 
It takes time for the camera to perform 
its various functions such as 
calculating exposure, focusing and 
recording the image to a memory 
card, and by time we mean a fraction 
of a second. But every millisecond 
counts in photography so you can 
help yourself by taking a moment to 
pre-focus before fully depressing the 
shutter button to take the shot.

 SHUTTER COUNT: A camera’s 
shutter count, or shutter actuation, is 
an indication of a camera's lifespan 
based on how many photographs it’s 
taken. Most entry-level shutters can 
reach a minimum of 150,000, and 
professional models 300,000, before 
showing signs of wear and tear. It’s not 
only the shutter count that determines 
a camera’s lifespan, though, servicing 
and environmental conditions are 
important too. To check your shutter 
count you could manually read the 
EXIF data or take a photo and upload it 
to camerashuttercount.com.

A Z OF PHOTOGRAPHYTO

SILHOUETTE: When a subject is
backlit and you expose for lighter areas
of the scene, that subject will almost
always be recorded in silhouette as
the camera underexposes it. It’s a
simple technique to use and results in
graphic images so long as the subject
has a strong outline.

SYNC CORD: As long as you don't
mind navigating extra cables, a sync
cord is a reliable and cost-effective
alternative to trigger off-camera flash.
This dedicated cable directly connects
a studioflash head with a DSLR so
when the shutter is fired, the flashes
are triggered simultaneously.

SHARPNESS: Soft, critical, pin-point,
out of focus are all adjectives that
depict an image or focal point's clarity
of detail. Images need to have an area
that is in focus to be considered sharp.
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SKYLIGHT FILTER: A Skylight filter is
mainly used to protect the front of a
lens from damage, dust and finger
prints like a UV filter is. Unlike UV filters
that are clear, Skylight filters do come
with a slight pink-orange tint that canwith a slight pink orange tint that can
add warmth to tones in a picture.

SELFIE: Rightly or wrongly, Selfie is
now a word in the Oxford dictionary
that was coined from the huge
popularity of smartphone self-popularity of smartphone self
portraits and their use in social media. 

STUDIO & STUDIO LIGHTING: A studio can be any enclosed space that provides a
controlled environment in which to take photographs, typically still-life or portraits. Both
studioflash and natural-light studios should contain resources to sculpt, modify and
control the light falling within the studio and on the subject. Most studios contain
multiple light sources, modifiers and backgrounds, whether that’s decorated walls, fabric
or paper backgrounds on a roll. Studio lighting could be in the form of continuous lights
or studioflash, typically powered by a mains outlet. A basic studioflash set-up consists of
two flash heads with softboxes or umbrellas but upgrading modifiers and adding more
lights expands creative potential. Elinchrom, Bowens and Profoto are all popular brands.
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SUBJECT DISTANCE: When photographers speak about subject distance they’re referring
to the space between the camera lens and the subject. Subject-to-camera distance is
important as it helps you to identify the aperture you need to use for the depth-of-field you
want to obtain. Similarly, your subject-to-background distance is an important factor if you
want the background to fall off into soft focus. The point at which you focus the lens
determines where the area of sharpness begins and ends – approximately it’s about one-third
in front of your point of focus and two-thirds behind. It’s why if you use a wide aperture, such as
f/2.8 on a subject a few metres away, you can still end up getting them entirely in focus; if you
use f/2.8 on a subject mere feet from you then you may find you only get a small area sharp.

SENSOR SIZE: At the heart of your 
camera is this solid-state device that 
captures light to form an image. The 
sensor uses millions of light-sensitive 
spots called photosites to record the 
light and colour information. The 
larger a sensor, the more light and 
information is recorded in an image, 
which usually delivers better dynamic 
range, increased detail and depth-of-
field as well as less noise and 
improved low-light performance. 
There are two main sensor sizes in 
DSLRs: full-frame (equivalent to 
35mm) and APS-C (with a crop factor 
of 1.5x or 1.6x, depending on the 
camera brand). In-between there’s 
the APS-H sensor and even smaller 
Micro Four-Thirds. Your sensor size 
also has an affect on focal lengths too; 
you have to multiply a focal length by 
the sensor’s crop factor to get the 
effective focal length. For example, a 
50mm lens used with an APS-C 
sensor with a 1.5x crop has an 
equivalent focal length of 75mm.

SCENE MODES: Along with Full Auto
mode, many entry-level cameras offer
automatic Scene modes that bias
particular camera settings to certain
subject matters. For instance, in
Landscape mode the camera will
automatically set a small aperture;
Portrait mode a wide aperture; Night
mode a high ISO. They’re each fully
automated but tailored to suit the 
most popular photo types.

is r...S
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STOP: Exposure is measured in stops – full
stops, half stops and third stops. A full stop
doubles or halves the amount of light in an
exposure. By increasing the exposure by
one stop, you’re capturing twice as much
light. You can do this by opening your
aperture, slowing your shutter speed or
adjusting your ISO sensitivity, and the
reverse if you want to halve the amount of
light. To keep the exposure the same, you
need to counterbalance any exposure
changes you make. For instance, if you
want to increase your depth-of-field by
closing your aperture a stop, for instance
from f/5.6 to f/8, you’ll either double your
ISO (e.g from ISO 200 to 400) or slow the
shutter speed (e.g 1/250sec to 1/125sec)
in order to keep the exposure the same.

STOCK PHOTOGRAPHY:  
An online marketplace where anyone 
can licence or buy images, stock 
libraries feature photographs from 
hundreds of photographers. They’re 
called ‘stock’ because they’re used for 
a variety of purposes – editorial and 
commercial – and not shot to a 
specific brief but licensed for specific 
uses. Popular images are of people at 
work, travel destinations and lifestyle 
photography. Macrostock agencies 
such as Getty Images and Corbis sell 
high-quality images by established 
photographers; Microstock agencies, 
such as iStockphoto and Shutterstock, 
are open to almost anyone and sell 
stock to the masses at a low cost. 

Spot metering
Unlike multi-zone metering

that takes exposure readings from
various segments of the image area,

spot metering mode takes a single reading
from a very precise spot. That area might be
in the centre of the frame or linked to your

active AF point so that you meter and focus
from the same area. It’s simple to use

and you always know what you’re
metering from, although it will only
be 1-3% of the visible image area, 

so you cannot afford to
be inaccurate.

SENSOR PLANE: Otherwise known
as your focal plane. As the surface of
your sensor is flat, to maximise
depth-of-field at any given aperture
you need to ensure you camera’s
sensor is parallel to the subject. If it’s at
even the slightest angle, you’ll find
depth-of-field will fall off much faster.
For instance, you could use f/2.8 to
get a front-facing portrait sharp from
eyes to ears but if you position them in
a three-quarter pose, you’ll likely only

hget one eye – at best – sharp. 

SENSITIVITY: Normally used in
relation to the ISO rating, sensitivity
indicates how ‘sensitive’ the imaging
sensor is to the light it receives. The
higher the ISO rating, the more
sensitive the sensor is to the light that
your aperture and shutter speed
allows in. High ISO sensitivities are
used in low light when you need the
sensor to be especially sensitive to the
limited light it receives. Conversely, a
high ISO in strong ambient lightinghigh ISO in strong ambient lighting
can result in an overexposed image.
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Get reflective: Autumn is a great time of 
year to head to a water’s edge. With the 
landscape so full of colour and atmosphere, 
it's the perfect season to shoot reflections, 

which have the power to dramatically enhance an 
image with strong foreground interest. For mirror-like 
reflections to occur on pools, ponds and larger bodies 
of water, you need a still, windless day. Keep an eye on 
the forecast and venture out on a day when the 
predicted wind speed is below 8kph (5mph). It is 
typically stillest around dawn, so get up early and head 
to the shore when you might be lucky enough to catch 
some morning mist, too, for added atmosphere. 
Reflections tend to be darker than the main subject,  
so you may want to attach a graduated ND filter to 
keep the scene's exposure balanced. By placing the 
horizon centrally across the frame you can create 
symmetry between the background and foreground, 
whilst a polarising filter can strengthen the appearance 
of reflections by removing glare. 

Shoot woodland interiors: This is surely the very best time of year to 
head into the woods. The leaf canopy is ablaze with fiery hues as the green 
pigment within leaves (chlorophyll) breaks down to reveal a palette of reds, 
oranges and yellows. The best of autumnal colour tends to appear in late 

October and early November, but this naturally depends on where you live. 
Meanwhile, peak colour can change one year to the next. Ancient, deciduous 
woodland will provide the best photo opportunities, boasting gnarled, shapely trees 
full of character, which photographers can use to harness their compositions. Bright, 
but diffused sunlight suits woodland photography when used with a polarising filter, 
which will eliminate glare and reflections and restore natural, saturated colours. 
Consider using footpaths or fallen boughs as lead-in lines or foreground interest.  
To give autumnal scenes extra 'oomph' and warmth, select a warmer colour 
temperature – for example, use Cloudy or Shade White Balance presets.

 1

 3
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Shoot a starburst: When shooting
towards the sun with a narrow aperture, sun
flare becomes what's fondly known as a
starburst. It's when the sun – or any bright

point of light – is transformed into a near-perfect star
due to the light waves bending or spreading, otherwise
known as diffraction. The smaller the aperture, the
more light diffracts, so a small f/stop in the region of
f/22 is usually the best choice for such effects but a bit
of experimentation might be needed. The number of
points in each starburst is related to the number of
aperture blades in the lens’s construction. Typically,
the more blades the better. Some lenses create better
bursts than others, so trial different lenses in your
system to see which creates the most appealing effect.
Try partly obscuring the sun behind a solid object, like a
tree, to control the flare and to help the rays stand
proud against the darker surroundings. Although
diffraction will soften image quality overall, it is justified
in this instance due to the creative effect.

 4
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Fun with fungi: Mushrooms and 
toadstools are some of the most obvious 
autumnal subjects. As summer’s warmth 
collides with the cool, dampness of autumn, 

the conditions are ideal for weird and wonderful fungi 
to appear on tree stumps and amongst the leaf litter. 
Ancient woodland tends to be a hotspot for fungi, so  
it's yet another reason to visit a local forest this season. 
Fungi come in all shapes and sizes, but many are quite 
small in stature, so a macro lens is recommended – or 
at least a close-up attachment of some variety. They do 
have a habit of growing in low, awkward places so a 
groundsheet can be useful. Woodlands are dark places, 
so expect to work in restricted light. Use a tripod with 
low-level capability for a worm’s-eye viewpoint. Use a 
reflector or LED light for extra illumination and a shallow 
depth-of-field to keep background clutter diffused. 

 2



Dewy cobwebs: As the atmosphere is
cool and moist it is not uncommon to wake
up to heavy dew on an autumnal morning.
Foliage and insects will be smothered with

tiny beads of water that glisten like jewels and highlight
the most intricate of spiders' webs. To record a web
sharp throughout, place as much of the subject
parallel to the camera to fall within the plane of focus.
Use a small aperture, like f/11 or f/16, but try to exclude
any distracting vegetation from the background. To
achieve more abstract results, place your camera at an
angle to the web and select a large aperture – in the
region of f/2.8 or f/4 – to highlight just a few droplets
or a single strand. Ideally, use a tripod and be careful
not to knock the web (or any vegetation supporting it)
when setting up. While webs alone create great shots,
don’t overlook their creators – autumn is a great time
of year to photograph spiders. Garden, orb weaver and 
wasp spiders are particularly photogenic. 
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Over the rainbow: Those post-rainfall
phenomenons have the ability to bring the
blandest of scenes alive and add impact to
the most foreboding of skies. Rainbows,

however, are not an everyday occurrence and rarely
appear just where you want them to, making them a
challenging subject. They form when sunlight passes
through rain, turning raindrops into tiny prisms. They
occur directly opposite the sun so can be easy to
predict. Autumn is a good time of year for rainbows as
the weather is so changeable, so if sunshine and
showers are forecast, head out with your camera. They
can be fleeting, so be prepared to work quickly. Attach
a lens hood to protect the front of the lens and keep a
lens cloth handy to wipe away any raindrops. Used
carefully, a polarising filter can intensify a rainbow and
a wide-angle lens can capture the full arc, but (with the 
sun directly behind you) be careful that your own 
shadow doesn’t creep into the composition. 
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Park life: Autumn is one of the best
times of year to photograph deer. The
rutting season is now in full flow, so if you
visit a local deer park, you are sure to see

lots of action. Stags, with impressive antlers, will be
bellowing and battling for supremacy. At big parks like
Richmond, in London, and Bradgate, in Leicestershire,
deer are very accessible and accustomed to people.
A focal length in the region of 300mm to 400mm will
allow you to capture frame-filling results from a safe,
responsible distance. For the most atmospheric
images, visit early morning when there is mist, or late
evening when the light is golden and dramatic. If
shooting within woodland, use tree trunks to frame
animals and increase the ISO to maintain a practical
shutter speed in poor light. A monopod can be the
best type of support when shooting deer, being 
lightweight and easy to manoeuvre. 

7





Go nuts: When you use natural foods, 
like nuts and seeds, to entice wildlife 
closer to your camera, it's a technique 
known as ‘baiting’. You can easily set up  

a feeding station in your garden to draw subjects to 
a pre-defined spot, or place a little hoard of nuts in 
your local park or woodland to attract for squirrels 
and birds to you photogenic location. Once you've 
baited your area, position yourself close by with 
camera at the ready. A collapsible, pop-up hide is a 
great help when doing this, disguising your 
whereabouts and movements from your subject. 
Visit www.wildlifewatchingsupplies.co.uk for 
options. A focal length upwards of 300mm is 
normally best. Select your camera’s continuous 
shooting mode so that you can fire a fast burst of 
images in order to capture the action.

 8



Get creative: Nowhere does it say you
have to record your subject conventionally.
Instead, get arty this autumn and use some
creative techniques to produce abstract

results. For example, if you are using a zoom lens,
rotate the zoom ring during the exposure for a
zoom-burst effect. Also try your hand at Intentional
Camera Motion (ICM), which is when you move the
camera while the shutter is open to blur your subject.
An exposure in the region of one second is a good
starting point and autumn trees provide the type of
colour and contrast that suits this technique. Your
camera’s multiple exposure mode can create different
effects, too, or mimic the Orton Effect by sandwiching
together a sharp and out-of-focus frame to create a
bright, dream-like glow. Creative techniques like this
often require a good degree of trial and error, so be
prepared to take a series of shots before you achieve 
the results you want and have some fun!

10
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Morning mist: A wonderfully moody
condition for photography, mist is best shot
in autumn. The atmosphere is moist, and
temperatures can drop significantly

overnight. A clear, cool night together with a low wind
speed will often result in radiation fog forming so keep
an eye on the local weather forecast. An early start is
important if you wish to capture the best of the
conditions before dew and mist evaporate in the heat
of the morning sunshine. Set your alarm early and
reach your chosen viewpoint before sunrise. Mist has
the ability to simplify and soften the landscape, which
when combined with autumnal scenery has the ability
to produce very special images. Whilst wide-angle
lenses are ideal for low viewpoints near large bodies of
water, longer lenses foreshorten perspective making
them ideal for higher viewpoints and when you want
to isolate shapes, layers and points of interest within
the landscape, like a tree, deer or birds. The brightness
of mist can fool metering systems into underexposure, 
too, so keep an eye on the histogram and apply
positive exposure compensation as required. 
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Head to the coast: Although trees and
woodland are undoubtedly autumn’s headline
act, don’t overlook the coast. As the season
changes, and the weather grows cooler and

less settled, the coast becomes less crowded. Stormy
weather blowing in from the sea brings impressive,
crashing waves and moody skies. Parts of some coastal
cliff tops are still carpeted with flowering gorse, heather
and scorched grasses that glow in golden sunlight. In late
autumn, beaches can be deserted and boast large
expanses of virgin sand and shapely tidal pools. Wrap up
warm, pull on your wellies, and get onto the beach. Push
the feet of your tripod firmly into the sand for stability and
try using solid ND filters to creatively blur the motion of
the tide as it laps in and drags out. The shorter days means
getting up for dawn, or staying out until after sunset, is a
far more appealing prospect. As you will know, these are
the best times of the day to capture moody coastal views.  

11



Harvest time: Autumn is harvest time, making
it one of the best seasons to visit and photograph
rolling countryside. Rural landscapes can get
overlooked by landscape photographers, yet they

are full of picture potential. During autumn, look for strong
shapes, patterns and textures within the landscape, like straw
and hay bales, stooks and plough lines. Elevated viewpoints
can provide good views for telephoto shots, allowing
photographers to capture the patchwork effect fields create.
Low morning or late evening sunlight is typically best, adding
warmth and dramatic long shadows to the countryside.

 12

Visit an arboretum: This is 
the perfect time to plan a day trip 
to a local arboretum. Places like 
Westonbirt, in Gloucestershire, 

and Winkworth, in Surrey, are now ablaze 
with seasonal colour. Arboretums are home 
to vast collections of trees, including acers 
and other species that are at their very best 
during the fall. Carry a good range of focal 
lengths with you as you will want to capture 
wide-angle, environmental shots of trees, 
along with close-ups of individual leaves 
using a macro or a telephoto lens. 
Backlighting often suits fall foliage best as  
it highlights details and their vibrance. So,  
if you visit on an overcast day, consider 
collecting a handful of fallen leaves to take 
home and photograph them on a lightbox 
later. Maple leaves are arguably the most 
shapely, colourful and photogenic.

 14
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Autumn fruits: Right now you
will find no shortage of berries,
nuts and seeds to photograph as
we enter the year's harvest time.

Conkers, acorns, fir cones and photogenic
seed heads provide great close-up potential,
with lots of fine detail, colour and interest to
highlight. It is likely you will need to arrange
and create your composition, although
sometimes things fall so naturally into place
that you won’t need to tamper with what
you find. When required, collect subjects
and assemble them to create a pleasing
composition or pattern, and then fill the
frame to maximise the impact of your
subject’s colour or shape. Soft, even sunlight
is typically best for this type of close-up, so
to maximise visible detail and saturation on
sunny days, shoot within the shade of a tree
or use a diffuser to reduce contrast.

Embrace the weather: Autumn is renowned for its unpredictable 
weather – glorious sunshine can quickly give way to heavy downpours, 
while fog and frost are not uncommon. This is good news for outdoor 
photographers as the most photogenic conditions occur when the weather 

is in transition, and autumn tends to provide moody skies, transient light and mixed 
weather conditions. Don’t hide away indoors if the forecast looks a bit 'iffy'; wrap up 
warm, don your waterproofs and take photos instead. Ensure your gear is protected 
from the weather by investing in a waterproof cover or rain sleeve and keep a lens cloth 
close to hand to wipe away raindrops or moisture from your lens or filters. Capturing 
transient light requires time and patience: identify your viewpoint and composition and 
then wait. Watch the clouds' movements and wait for a gap to move towards the sun 
and be ready to trigger the shutter as light dances across the landscape.

 13
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CITY STREETS
CITYSCAPE PHOTOGRAPHY IS A MUCH WIDER GENRE THAN IT FIRSTAPPEARS AS THERE ARE MANY POSSIBLE APPROACHES.

WE CHALLENGED ONE READER TO CAPTURE THE ICONIC CITY OF CAMBRIDGE USING SEVERALTECHNIQUES AND NOTHING
MORE THAN HIS CAMERA, A 50MM LENS AND ATRIPOD FOR WHEN LIGHT LEVELS DROPPED IN THE EVENING

The Photo Workshop

 C
AMBRIDGE IS A historical city that 
needs little introduction, thanks to its 
worldwide reputation as an 
educational centre of excellence and 

its iconic architecture, not to mention many 
links to history and science. But while much 
of what the city is most famous for occurs 
behind closed doors, the city streets are 
hugely popular with both domestic and 
international tourists, and in normal times 
tens of thousands of photos will be taken in 
and around the city every day.

The city is undoubtedly a beautiful place 
and one that’s a joy to walk around and soak 
up, but while it’s picturesque, it’s not 

necessarily the easiest city for 
photographers to shoot because there are 
no hills from which to capture sweeping 
vistas or even buildings that stand out from 
the rest. This certainly doesn’t mean that it’s 
impossible to shoot great cityscapes of 
Cambridge, though; by focusing on the 
narrow streets, the action that takes place 
within them and some visually interesting 
landmarks, there are many opportunities  
if you’re motivated enough to pound the 
streets to discover them.

With sunrise still early and opportunities 
for shooting it from within the city limited, 
the plan was to meet in the middle of the 

day and shoot until sunset. Professional 
photographer James Abbott and reader 
Chris Moss, who had never been to 
Cambridge before, were limited to using just 
one lens – a 50mm f/1.8 – along with 
completing three challenges that drew on 
completely different skillsets.

Despite the limitation of using a single 
prime lens and three totally different 
approaches to capturing city images,  
Chris’s results are visually and technically 
interesting and his creativity was never put 
into question. In fact, it thrived and pushed 
him to think on his feet and experiment,  
so let’s see how he got on… 

ChrisprovidesITConsultancyand 
runs a web design business. He’s 
had a passion for photography since 
university, which was re-ignited 
after starting a young family.  

Chris enjoys macro, landscape and portrait 
photography of his children as they grow up. 

Chris's kit: As part of the 50mm Cambridge 
cityscape challenge, Chris’s kit was limited to his 
Nikon Z 6, Nikon Z 50mm f/1.8, K&F Concept 
travel tripod and an unbranded remote release.

OUR READER: Chris Moss

Jamesisaprofessional landscape 
and portrait photographer based in 
Cambridge. With a love of travel and 
the outdoors, he frequently visits 
locations around the UK to expand 

his portfolio and create photographic tutorials 
for beginners and advanced photographers. 

James’s kit: Sony A7R III, Sony FE 16-35mm f/2.8 
GM, Sony FE 70-200mm f/4 G, NiSi filters 
system, Vanguard Alta Pro 2 263CB tripod and 
Mindshift Backlight 26 backpack.

OUR EXPERT: James Abbott



CHALLENGE 1: DETAILS
Meeting in a city usually requires one of us
to hold a giant sign saying 'over here, it's
me!' to distinguish us from the crowds, but
the silver-lining to these dark times is that
the city is significantly quieter than usual.
Chris and I quickly found each other near
my very secret parking area that avoids
the extortionate parking charges that
Cambridge is infamous for.

We made the 15-minute walk into the city
centre and discussed the plan for the day.
Chris was feeling slightly strange about only
having a single lens to use, but I explained
that only using a 50mm would in many
ways be much better than using a zoom or
having multiple lenses because of its wider
aperture. You can still ‘zoom’ with your feet
and it means you can travel light. Chris had
a small backpack to carry a some personal
items but he didn’t feel the need to have a
dedicated camera bag with such limited kit.

We arrived at King’s Parade in front of
King’s College and wandered around while
I explained that the first challenge was to
focus on the details that make Cambridge
so charming. It was a warm-up exercise to
get him used to working with a 50mm lens
but also looking at how a city is the sum of
all its parts, from grand building to its easily-
missed, character-filled details.

When you think of Cambridge, the objects
that spring immediately to mind are bikes

and punts, so Chris naturally found himself 
drawn to these. He started off capturing 
tighter detail shots using differential focus 
to highlight different parts of classically 
styled bikes, so things like seats, horns and 
baskets. There’s only so much time that 
you can spend on this way of shooting, so I 
suggested that we look for some lone bikes 
against plain backgrounds to get a few wider 
shots, and took Chris to a place where I was 
certain we’d find what we were looking for.

We wandered down to where I was 
thinking, and passed the famous singing bin 
man, who Chris grabbed a few shots of, and 
found that there were a couple of lone bikes 
where I had expected there to be; the first 
was a blue bike against a dark wall and the 
second was a green bike that was almost 
the same tone as the bush above and was 
leaning against a lighter wall. The second of 
the two bikes was the more interesting shot 
on a subtle level.

We were coming to the end of the first 
challenge so I suggested we walk down 
to the river to find some packed punts to 
shoot. When we arrived, it turned out that 
this particular punt hire didn’t lock its punts 
together in an interesting way so we headed 
across town to the mill pool to find what 
we were looking for. Chris spent about 20 
minutes shooting a variety of images before 
we headed back into the city centre.

2
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ALL IN THE NAME 
Differential focus has helped to  
draw attention on the desired part  
of the frame while the focus fall-off 
maintains the context of the scene.

Exposure: 1/1600sec at f/1.8 (ISO 125)

The Photo Workshop
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“Thefirstchallengewasextremelyrelaxedand
allowedChris toeaseintotheformatofthe
workshop,aswellashelpingustodoarecceof
thecitycentretoseewherewemightwantto
shoot laterintheday.Detailsaren’tanexciting
subjectbutthisdoesn’tmeanthatyoucan’tuse
avarietyoftechniquestomakethemlookmore
interesting,andChrisdidn’thesitatetouse
differential focusanddifferentfocuspointsto
experimentwithemphasisingdifferentpoints
ofinterestonasinglesubject. Itwasstrangefor
Chris tolimithimselfwithasingle lens,buthe
quicklygrewintothechallenge.Welldone!”

CHALLENGE 1 Pro verdict

1) Chris used Live View to compose a low shot. 2) Shooting 
from a higher viewpoint. 3) Shooting at f/1.8 in aperture-
priority for a shallow depth-of-field. 4) Dialling in settings to 
lengthen exposure time. 5) Chris captures a variety of bike 
details and wider shots to capture a sense of place.
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CHALLENGE 2: MOVEMENT
During the first challenge, Chris had
become interested in the KEEP LEFT signs
stencilled onto the floor to guide shoppers
to maintain social distancing, although
completely pointless because few people
were paying attention to them. Chris
noticed this and began capturing abstract
images of people walking against the
instruction and took some interesting shots
that straddled both challenge one and two 
by incorporating detail and movement.

Chris kept shooting these when the
opportunity arose, but we now positioned
ourselves next to Gonville and Caius
College, where we would see a steady
stream of cyclists passing so Chris could put
his panning skills to the test. We discussed
the technique and Chris said that he had
tried panning before but with limited
success, so I gave him a recipe of settings
and a few tips to fast track him to success.

When panning, it’s best to shoot in
shutter-priority so that you can set the
shutter speed and the camera will take
care of the aperture. I asked Chris to set
this mode with ISO at 100, shutter speed
at 1/30sec and continuous AF to track the
moving subjects so to ensure the cyclists
remain sharp. I also asked him to turn on the
IBIS in his Nikon Z 6 to help stabilise shots.

When panning cyclists travelling at what
you might call a normal speed, a shutter
speed of 1/15sec or 1/30sec are usually
ideal, so Chris experimented with both 

options to see which provided a sharp
cyclist with enough motion blur behind,
and 1/30sec was indeed perfect so he
stuck with this setting, applying just a small
amount of exposure compensation, and
continued shooting.

With these settings, Chris’ technique
was looking great, with nice sharp subjects
and plenty of background blur, but the
problem he was having was with timing
and composition; he was capturing the
cyclist either too early or too late so their 

The PhotoWorkshop
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angle in the frame was wrong, and in some
cases they were too small in the frame. I
suggested that Chris release the shutter at a
specific point as the cyclists passed, and his 
hit rate began to creep up.

Once Chris was confident he had a
selection of shots that worked, we moved
onto a different technique. I asked him to
switch to aperture-priority mode and to set
f/1.8 and ISO 400 to create a faster shutter
speed so as to freeze cyclists' movement.
The aperture and ISO combination resulted 
in 1/800sec, which was perfect. 

This approach to capturing movement
was so that Chris could include context
from the environment. By focusing on the
writing on the wall at a wide aperture, he had
a sharp foreground with a soft but with still
a recognisable background. When a cyclist
rode into the frame, Chris was then able to
fire off the shutter to capture a frozen subject
blurred by shallow depth-of-field. Since
Chris was around a corner and couldn’t see
cyclists approaching, I stood on the road to
let him know when to shoot and the process 
worked reasonably well.

“Panningisanadvancedtechniquethatalways
providesinstantgratificationbecauseyou
achieveahighlydynamiceffect in-camera.
Chrisquicklygottogripswiththetechnicalside
ofthingsandwascapturingtechnically
competentimages,buthiscompositionand
timingneededalittlemorework.Withjustafew
tweakshewascapturinggreatpanningshots
thatformedthebackboneofthechallenge,with
equallyinterestingshotsfreezingthemovement
ofcyclistsandalsopedestrianswiththeimages
thatcrossoverthisandthepreviouschallenge.
Overallahighlysuccessfulchallengethat
allowed Chris to develop some solid skills.” 

CHALLENGE2 Pro verdict

1)Panningpassingcyclists.2)Chriswaits forcyclists to
capturesubjectbluragainstasharpbackdrop.3)Focusingon
foregrounddetail.4)AssessingresultsontheLCD.5)Hiding
awayinadoorwaytobelessconspicuous.6)Focusingonthe
foregroundwithashallowdepth-of-field.7)Focusing on 
subject blur for a different approach.
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DYNAMIC MOVEMENT
Cambridgeis theperfectplaceto

capturepanningshotsofcyclistsand
Chrisquicklyperfectedhistechnique.

Exposure:1/30sec at f/7.1 (ISO 125)

6 7



 CHALLENGE 3: SUNSET
With the pedometer on my watch telling 
me that we’d already walked over 20,000 
steps, we decided to take a quick and 
well-deserved break before embarking 
on the third challenge. At this point it was 
5.30pm, so we had a generous two whole 
hours until sunset – a first for me to have so 
much time to lead the third challenge – but 
knowing how quickly time can ebb away, I 
wasn’t willing to fall into the trap of relaxing.

The first planned location in the run-up to 
sunset was Trinity Lane, which is a famous 
old lane running between college buildings 
with iconic chimneys on the roofs of the 
student accommodation on the right. As we 
made our way there, the light coming down 
Senate House Passage looked amazing, 
so Chris quickly grabbed a hand-held shot 
without any filters that worked well once it 
had been processed.

After a minute or so, we arrived at Trinity
Lane and Chris grabbed some silhouette
shots of the chimneys against the interesting
sky. Once he’d finished, I suggested he
also grab the components for a HDR shot
so he set up the autobracketing feature on
his Z 6 to take five exposures at one-stop
increments. He grabbed a couple of sets
before we packed up and made the walk
to the other side of town where we would
shoot the Mathematical Bridge, ideally with
a punt or two on the River Cam.

As we approached the bridge we’d be
shooting from, the light was looking much
better than it would at sunset since the sun

was higher in the sky and was gently lighting 
the buildings on the right of the scene. Using 
his tripod would have cost Chris valuable 
time, so I suggested that he use his jumper 
to support the camera and shoot bracketed 
exposures again to maintain sky detail. Chris 
took a few shots and as we could see a few 
punts approaching from roughly 30m away, 
so didn't have to wait long. This was lucky 
because punts can add interest to shots of 
the Mathematical Bridge by removing the 
static characteristics of the scene.

Two of the punts passed beneath the 
bridge we were standing on, but one turned 
to go back the way it came so this gave 
Chris time to make sure his settings were 
right for the final few shots at this location. 
Once the punt began passing beneath the 
bridge, I signalled to Chris to begin shooting 
and reminded him of the best point of 
focus to ensure a large depth-of-field 
while shooting at f/11. Although there was
movement in the scene with the lone punt
passing under the bridge, Chris’s processing
has successfully removed any ghosting and
the result was a natural-looking HDR image.

We had enough shots for the final
challenge, but there was one final spot I
wanted to visit on the way back to where
we’d parked – the public bridge to the back
and side of Trinity College where you can
get great views of the river in each direction,
although looking south is the better of the
two. Chris quickly grabbed an HDR shot of
the river view and one looking down Garret
Hostel Lane towards Trinity before we
packed up and walked back to our cars.

CHALLENGE3 Pro verdict
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The Photo Workshop A FAMOUS LANDMARK 
The Mathematical Bridge always looks 
best when there’s a punt in the scene to 
add a human element to the shot.

Exposure: 1/30sec at f/11 (ISO 1000)

“Throughout the day, Chris remained extremely 
receptive to advice and blended this with his 
existing knowledge, which was limited with 
regards to cityscape photography but a solid 
foundation to build upon. The third challenge 
touched mainly on HDR, which is something 
Chris had tried previously meaning we could 
concentrate more on the compositional aspect 
of shots. Chris worked quickly to capture light as 
it changed – a challenge his usual subjects don’t 
present. Overall he did a great job." 



WORKSHOPSUMMARY:
ChrisMoss

“Visiting Cambridge provided 
many new and exciting 
opportunities to capture the 
details that make Cambridge such 
a beautiful location. Having never 

visited the city before, I became engrossed by  
its character, even during these unusual times 
making it much quieter than normal, according 
to James. The second, and my favourite, 
challenge allowed me to explore panning and 
slow shutter speed techniques, which are very 
different from my experience shooting macro. 
My confidence improved throughout the day, 
particularly as James helped with composition 
and improving my technique. I’d love to re-visit 
Cambridge to have another go!”

1) Capturing as many locations as possible in the run-up to 
sunset. 2) Chris rests his camera on a bridge. 3) Setting up the 
camera to shoot bracketed exposures for HDR. 4) Trinity Lane 
in HDR to maintain detail throughout the high contrast scene. 
5) The last shot of the day as the streets grew even quieter.
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Words: DANIEL LEZANO

nature 
uncovered
DO YOUR NATURE IMAGES LACK IMPACT, INNOVATION AND IDEAS? IF YOU ARE LOOKING TO GIVE 
YOUR PHOTOGRAPHY A SHOT IN THE ARM, THEN LOOK NO FURTHER THAN BEN HALL AND ROSS 
HODDINOTT’S LATEST TITLE, 52 ASSIGNMENTS: NATURE PHOTOGRAPHY. THIS NEW PUBLICATION 
HAS A FRESH AND FUN PROJECT FOR EVERY WEEK OR THE YEAR AND AIMS TO GET YOUR CREATIVE 
JUICES AND ENTHUSIASM WELL AND TRULY FLOWING. DANIEL LEZANO TALKS TO THE AUTHORS 
ABOUT THE INSPIRATION FOR THE BOOK AND THE CHALLENGES OF COAUTHORING… 





the big interview

OLLABORATIONS SEEM TO 
be the big thing at the moment. 
The download charts are full of 
artists pooling their skills – and 
now this trend appears to be 
spreading to photography 

projects, too. And why not? Most 
photographers are specialists in niche areas 
– you can’t be good at everything – so by 
working together, photographers with 
different skillsets and expertise can produce 
a far more comprehensive and competent 
piece of work. It's the reason why Ben and 
Ross decided to work together on this 
assignments title, rather than go it alone.

Ben and Ross are two of the UK’s 
best-known nature snappers and will 
already be familiar to readers of Digital SLR 
Photography as both are long-standing 
contributors to the magazine. Together, they 
have more awards for their photography 
than you can shake a stick at. However, they 
tend to shoot very contrasting subjects.  
Ben is recognised for his sublime and 
communitive images of birds and mammals, 
with an instinct for using the subject’s 

environment to tell stories. Meanwhile,  
Ross is renowned for highlighting the beauty 
and design of much smaller, miniature 
subjects – secretive little creatures that are 
often hidden beneath our feet. While their 
preferred subjects and styles might differ, 
they share a passion for nature and a 
recognisable flair and class. Between them 
they have an extensive knowledge of 
shooting all things wild, which is why this 
latest collaboration makes so much sense. 

The new Covid world that we will live in 
requires me to talk to the two photographers 
through Zoom call, rather than face to face, 
but while that feels slightly odd and 
awkward at first, we are soon laughing and 
chatting openly. Both guys are very laid 
back and refreshingly easy to speak to – 
clearly neither take themselves too 
seriously. Before long we get on to the 
subject of how the two photographers first 
got to know each other. Ben goes on to 
explain: “We briefly spoke at the inaugural 
British Wildlife Photography Awards around 
ten years ago. We were both category 
winners that year and managed to grab  
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the big interview

a quick conversation among all the chaos 
and bubbly. Then, a couple of years later,  
we worked together on a large multimedia 
conservation project called 2020 Vision and 
just got on really well. Nature photographers 
are so accustomed to working alone, that it 
can be quite a shock to the system to actually 
work with someone else. But Ross and I have 
plenty in common besides our passion for 
nature, conservation and photography. We 
both discovered photography as kids and 
pursued careers within the industry at a 
young age. We are the same generation, with 
wives in similar professions and with kids  
of similar ages. We just clicked immediately, 
if you will excuse the pun.” Ross continues: 
“A few years later I was asked to lead a 
workshop to the Galapagos Islands, which is 
a dream destination for any nature lover or 
photographer. The tour operator wanted 
another tutor and I immediately 
championed Ben, as he is such a creative guy 
and an excellent technician and tutor. We 
ended up doing two tours to the archipelago 

over two years, and they are among the best 
trips I’ve ever run. Not only was it an 
amazing experience to photograph the 
islands' extraordinary and unique wildlife, 
but Ben and I became really good mates.  
We recognised that the subjects we shot,  
and our individual styles and personalities, 
were very complementary and, over a few 
pints one night, we came up with the idea  
of coauthoring The Wildlife Photography 
Workshop, which was published in 2013.  
The title sold well, and in several languages, 
and I think we realised that collaborating  
on certain projects benefited us both.”

Ben lives in Cheshire, while Ross is based 
in north Cornwall, so does the distance 
between them complicate things when 
working on a project together, such as their 
new book, 52 Assignments: Nature 
Photography? “It's surprisingly easy, 
actually,” Ross explains. “We try to meet up 
in person initially to do a bit of brain 
storming, but then we just chat via Skype. 
The Assignments book is part of a series 

 We recognised that the subjects we shot, and our individual 
styles and personalities, were very complementary
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     Like almost every professional photographer today, both 
Ross and I earn a decent chunk of our income through tuition
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created by our publisher, Ammonite Press, 
so there is an existing formula and structure, 
which made our lives easier. We compiled a 
list of around 60 potential projects, which 
we then refined to 52 together with the 
publisher and editor. Once we had our final 
list of assignments, we split them equally 
between us. We did this like you might select 
a football team in the playground, taking it 
in turns to pick the projects we wanted to do 
until we both had 26 assignments each to 
write and illustrate. We then just lock 
ourselves away in our respective offices and 
prepare material in readiness for the 
deadline” Ben adds. “We regularly exchange 
messages and compare chunks of text to 
ensure consistency and avoid repetition. 
And occasionally we will ask each other for  
a specific shot to illustrate a specific 

technique. However, overall, it is a fairly 
straightforward process. We both have quite 
similar writing styles, which helps the book 
flow well. I don’t think it is obvious at all that 
it is written by two people.” 

Ben and Ross completed the material 
earlier in the year, before all our lives were 
turned upside down by the pandemic. I’m 
curious to know how their lives as nature 
photographers have changed over the past 
few months. “It’s been such a difficult time 
for everyone, hasn’t it?”, Ben says. “Like 
almost every professional photographer 
today, both Ross and I earn a decent chunk 
of our income through tuition, but all our 
workshops had to be cancelled throughout 
spring and for most of the summer. 
Meanwhile, trips have had to be cancelled 
and personal projects put on pause due to 
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52ASSIGNMENTS:
NATURE PHOTOGRAPHY
RRP:£12.99/AmmonitePress

52Assignments:Nature
Photography isacollectionof
mini photographic workshops 
and an inspirational guide to 
putting the creativity back 
into your craft. It is handbook 
sized, so small enough to fit 
into your backpack and carry withyouwhile
you are out shooting. It is filled with a year's worth 
of weekly projects and ideas for composing and 
creating eye-catching nature photography in all 
its forms. Whether that is building your own hide, 
setting up a feeding station, shooting macro, 
creatingbeautifulanimalsilhouettesorcapturing
birds inflightorfocusingonnatural textures.By
the time you complete the final assignment, you 
will feel more creative and motivated to explore 
thenaturalworldaroundyou.At£12.99it's the 
perfectstockingfillerforanyphotographerthis 
Christmas.BuyonlineatAmazonorat: 
 www.rosshoddinott.co.uk/shop.

 MORE ON THE BOOK…

the big interview

 You are far more likely  
to capture unique or 

innovative images of nature
by working regularly and

closely with local species
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the restrictions on travel. Obviously, that 
has had a financial impact, but then who 
hasn’t been adversely affected by Covid-19? 
It’s been one crazy, surreal year.” Ross goes 
on to explain: “I co-run Dawn 2 Dusk 
Photography, which specialises in 
photography workshops. Ben is one of our 
tutors. Lockdown created a huge logistical 
headache, trying to rearrange courses, 
communicate with hotels, and keep clients 
informed and reassured. It’s been a 
balancing act trying to juggle a mountain of 
admin, home-schooling kids, while also 
trying to do some work and photography to 
keep pennies trickling in. Yes, it’s been 

tricky, but our families are happy and 
healthy, and that really is the bottom line. 
2020 has taught us all to get our priorities 
straight. And there have been positives too. 
Ben and I both enjoy working close to home 
and developing an intimate knowledge of 
local subjects. You are far more likely to 
capture unique or innovative images of 
nature by working regularly and closely 
with local species as you develop a clear 
understanding of their behaviour and 
environment.” Working close to home is  
just one of the assignments Ben and Ross  
set readers in the book, and the topic seems 
particularly apt this year of all years. 
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 Nature photography is such a competitive arena today, with an 
abundanceofgoodphotographers,alltryingtomakeaname
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Both photographers have received 
recognition for their nature images in the 
UK and internationally, so I can’t help but 
inquire what the key ingredient is that 
makes an award-winning image? “That is 
such a tricky question to answer”, Ben 
responds. “Often it is a combination of 
things. It might be unusual behaviour, 
atmosphere and mood created by the light, 
season or conditions.” “Originality always 
helps images stand out to the judges,” Ross 
adds, “so a creative or unconventional 
approach is important – don’t try to simply 
replicate other images or previous winners.” 

As we chat, I flick through a copy of the 
book. The quality of the imagery and artistry 
jumps out and the authors cover such a huge 
and diverse range of subjects, ideas and 
techniques. It really is a neat, cleanly 
designed little book that is sure to get your 
creative juices flowing. The projects don’t 
have to be done in any particular order and 

some of the assignments are longer-term 
projects, while others can take just hours to 
complete. It's a book that you can dip in and 
out of – a real achievement, but what's next 
for the pair? I ask Ben and Ross if they have 
plans for any other future projects. Ross 
answers: “Nature photography is such a 
competitive arena today, with an abundance 
of good photographers, all trying to make a 
name. I think we both recognise that you can 
be stronger working together than alone. 
And while we have no immediate plans to 
coauthor another book, we do enjoy 
working together and I’m sure we will 
collaborate again on other projects.” Ben 
adds: “Meanwhile, we hope to run more 
workshops together over the next few years. 
Coronavirus has rather wrecked the plans we 
had for a few overseas workshops we’d been 
discussing. However, there is plenty to shoot
in the UK while we wait for things to settle
down and travel restrictions to ease again.”  



SOUTH WALES
DESPITE ITS RELATIVELY MODEST PROPORTIONS, WALES CERTAINLY DOES NOT SUFFER 
FROM A LACK OF PHOTOGENIC LOCATIONS. QUITE THE OPPOSITE IS TRUE AS THE LAND  
OF DRAGONS IS BRIMMING WITH FABULOUS SCENERY, FROM RUGGED MOUNTAINS  
AND ROLLING GREEN HILLS TO DRAMATIC COASTLINES. WHILE THE NORTH OF THE  
COUNTRY IS BEST KNOWN FOR THE MAJESTIC MOUNTAINS OF SNOWDONIA, AND THE 
WEST FOR ITS FABULOUS COASTLINE IN PEMBROKESHIRE, SOUTH WALES COMPRISES 
ELEMENTS OF BOTH WITH SIMILAR TERRAIN OFFERING UP A BEAUTIFUL PACKAGE OF 
BOTH SEASCAPES AND LANDSCAPES TO ENTICE EVERY VISITING PHOTOGRAPHER

With AdamBurton �������	
��





1)LlynyFanFachviewedfromthewalkuptothesummitof
PicwsDu.2)AerialvistaofCarregCennenCastleatdawn.
3)TranquildawnatLlangorseLakeintheBreconBeacons.
4)HawthornsandrollingcountrysideoftheUskValley.
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I
T MAY NOT have the lure of the Lake
District, the charms of Cornwall or the
seduction of Skye, but what South Wales
does offer is an incredible variety of
locations to photograph, all relatively
close in proximity. And, unlike many of

the better known photogenic locations in
the UK, are for the most part easily
accessible by a network of excellent roads.

If you based yourself just to the south of
the Brecon Beacons National Park, it would
be quite possible to access every location
described in this article within an hour’s
drive. Although, with so much to see and do
in each area, it would be preferable to put
aside enough time to have several bases.
Alternatively, bearing in mind how simple
South Wales is to reach for many people,
why not make several shorter trips to fully
explore each area?

Whether you decide on one big trip or
several smaller excursions, there is a lot to
see and shoot in this area, so be sure to
allocate enough time. A week-long trip will
give you a good taste of the region;
alternatively, several long weekends will be
perfect for exploring the areas covered here.

Although there is so much to see, for the
purposes of simplification I have split South
Wales into three geographic areas: the
Brecon Beacons, the Gower Peninsula and
the Glamorgan Heritage coast.

Brecon Beacons
One of three National Parks in Wales, the
Brecon Beacons cover a vast area in South
Wales – around 520 square miles. Much of
the landscape consists of wild mountain
ranges, but in between lie some of the finest
rolling countryside to be found anywhere in
Britain. Thanks to a good road network, the
eastern half of the National Park is the most
accessible. The towns of Brecon, Crickhowell
or Abergavenny all situated along the A40
offer excellent bases for exploring the area.

The Brecon Beacons National Park
consists of three mountain ranges, with
names designed to confuse! There is the
Brecon Beacons in the middle, the Black 

Mountains to the east and the Black
Mountain to the west. If you are seeking
solitude with miles of wilderness all to
yourself, head over to the Black Mountain.
The twin lakes of Llyn y Fan Fawr and in
particular Llyn y Fan Fach make excellent
locations to explore. The latter is in a
beautiful setting, nestled in a horseshoe in
the shadow of Picws Du, the second highest
mountain in the Carmarthen Fans.

Further to the west, perched on the
summit of a rocky outcrop close to the
border of the National Park, Carreg Cennen
is one of Wales’ most spectacularly
positioned castles. Yet, in a land so famous
for it’s ancient fortresses, Carreg Cennen
rarely gets a mention. There are various vistas
where the castle can be photographed from
both near and far. For the very best view pack
your telephoto zoom and drive up the little 
mountain road to the south east of the castle.

Returning east towards the Brecon
Beacons, it's well worth stopping off near the
village of Ystradfellte to experience some of

DID YOU KNOW?
The SAS use the Brecon 

Beacons as a key training area 
due to its remoteness and 

harsh, unpredictable 
weather.
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AdamBurtonisoneoftheUK’s
leadingprofessional landscape
photographers.Photographer,
teacherandauthorwithover15
yearsexperienceworking
withinthephotography

industry,Adamhasphotographedmanyofthe
world'sbeautifulnaturalareasandspecialises in
thelandscapesoftheUK,particularlysouthwest
England.Entirelyself-taught,Adam’sstylehas
developedorganicallythroughphotographing
thewidevarietyoflandscapesandseascapes
foundwithintheUK.Hisbold,colourful
landscapesarealways in-demand;hisclient list
includesmanyprestigiousorganisationssuch as 
NationalGeographic,FordandTheAA.
www.adamburtonphotography.co.uk
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Wales’s best waterfalls. Aptly nicknamed
Waterfall Country, this area is blessed with a
plethora of beautiful large cascades, and
makes the perfect destination to head to on
dull, overcast and even rainy days. Most of
the waterfalls can be found in close proximity
along two rivers, the Nedd Fechan and the
Afon Mellte, including the famous Sgwd yr
Eira falls that you can walk behind.

After visiting Ystradfellte, head towards
Brecon initially on the A3059 before turning
onto the A470. Soon after passing the
Beacons Reservoir on your left, turn right into
the large car park. This is the main starting
point for the walk up to the summit of Pen y
Fan, at 886m it's the highest mountain in
southern Britain. Despite its height, Pen y Fan
is a fairly simple mountain for most to
summit as the route involves a slow
continuous slog along a well maintained
path. It’s a right of passage amongst the
Welsh, and as a result you are likely to share 
the journey with a continuous flow of
walkers all heading to the summit.

The views from the top are spectacular,
and well worth the effort. Like all the
mountains in the National Park, Pen y Fan
and its sister peak Corn Du have flat summits,
making ideal locations to set up a tripod on,
providing of course it's not blowing a gale!

Many of the most photogenic spots within
the National Park can be found just to the
east of the Brecon Beacons range, in the Usk
Valley. The rolling countryside vistas here are
delightful, and with the surrounding hills and
mountains there are plenty of opportunities
to find high vantage points to shoot down
over the patchwork fields. If you can drag
yourself out of bed early enough on a cool
still morning, head up to one of the nearby
hills armed with your telephoto zoom, and 

1) Morning mist hanging low in the Usk Valley. 2) A long 
exposure of the Sgwd Gwladus waterfall. 3) The abandoned 
quarry below the Llangattock Escarpment. 4) Canal boat 
moored up on the Monmouthshire and Brecon Canal. 5) An 
inversion hides Llangorse Lake below a cloud of mist at dawn. 1

2 3

DID YOU KNOW?
Henrhyd Falls, the tallest 
waterfall in the Brecon 

Beacons, was the location 
used for the Bat Cave in  
the Dark Knight Rises 

movie.
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SGWDGWLADUS(THE LADYFALL):Situated on the
Afon (River) Pyrddin, this elegantwaterfall is a favourite
amongst photographers.Thewatercascades from a high
ledge and falls into awide shallowriverbed.You can set
up on eitherside ofthe riverand use exposures ofseveral
seconds to record the bubbles as streaks in thewater.

SGWDYR EIRA(FALLSOFSNOW):Probablythe most
well knownwaterfall in the Brecon Beacons, and famous
forbeing thewaterfall thatyou canwalk behind, Sgwdyr
Eira isverybeautiful. Located on theAfon (River) Mellte,
thewaterfall is not the easiest to reach,with a two-mile
walk through hilly woodland from the nearest car park.

SGWDDDWLIUCHAF(UPPER GUSHINGFALLS):
Similar in appearance to SgwdyrEira, this grandwaterfall
on the Nedd Fechan river is a simple ten-minutewalk
from the carpark at Pont Melin-fach.Thewaterfall looks
great as a subject in its own right, orwhen photographed 
as a backdrop to awide-angle rushing river image.

SGWDDDWLI ISAF(LOWERL GUSHINGFALLS):The
lowerfalls are anotherten to 15 minutes from Sgwd
Ddwli Uchaf, so can be easilyphotographed on the same
trip.There are two sets of falls here: the lowerbeing small
but more photogenic due to moss-covered ledges on
the riverbed, which can make great foreground subjects. 

 BRECON BEACONS  WATERFALLS

shoot the landscape below as it's immersed
in the magical beauty of morning mist.

When in the area, be sure to pay a visit to
Llangorse Lake. South Wales’s largest natural
lake is a wonderful place to while away a few
hours with the camera. At the north end of
the lake, near the Sailing Club, there is a wide
choice of subject matter to fill foregrounds in
wide-angle compositions. There are usually
rowing boats and small fishing boats pulled
up along several jetties, plus a couple of
wooden jetties, which always make
compelling subjects. Most interestingly,
look out for the reconstructed crannog (an
ancient building built on an artificial island).

The real crannog is situated just offshore,
believed to have been constructed in 916AD
as a home for the King of Brycheiniog.

Just to the south of the A40, running
roughly parallel with the River Usk, the
Monmouthshire and Brecon Canal offers
a pretty and peaceful place to wander with 
your camera. The canal is extremely
photogenic along its course, and looks
especially pleasing on still days when the
calm water is reflective. There are too many
places to describe here, but if you are
looking for a couple of photogenic spots
where the canal passes through, try the
village of Llangattock or Talybont on Usk. 

54
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near the Old Coastguard Station. From here,
Worms Head looks like an island at high tides
or is connected to the mainland via a huge
rocky ledge when the tide is low.

You can walk down the cliff footpath here
to shoot low-level seascapes looking out
towards Worms Head, or alternatively turn
left and continue walking for another 15
minutes to reach Fall Bay. If you decide to
walk the extra distance to reach Fall Bay, you
will be in for a treat. The coast comprises a
series of angular ledges extending into the
sea, with a dramatic backdrop of limestone
cliffs across the bay into the distance.

Less than a mile along the coast from here
is another highlight of the Gower Peninsula,
Mewslade Bay. To appreciate everything that
Mewslade has to offer, you really need to visit
during a low tide. At this time, the beach
consists of pointed rocks emerging from
golden sand, with fascinating angular cliffs
towering above. Mewslade is incredibly
unusual, and the geology unique to this area.

Although most of the photographic
highlights can be found in the south-west
corner, the whole south coast is worthy of
exploration. From Mewslade the cliffs are

Gower Peninsula
The beautiful Gower Peninsula, near
Swansea, has long been highly regarded for
its lovely coastal scenery. In 1956, it became
the UK’s very first area to be designated an
Area of Outstanding Natural Beauty (AONB).

At only 70 square miles in area, the
peninsula is fairly compact and therefore
pretty easy to get around. From a
photographic perspective the south and
west coasts are the most appealing, with
miles of dramatic limestone cliffs and some 
incredibly beautiful beaches.

Most of the Gower’s photographic
highlights are clustered around a small area
in the south-west corner of the peninsula,
near the village of Rhossili. Conveniently, a
hotel right on the cliff tops here makes a
perfect base to stay while exploring the area.
The hotel overlooks the sweeping golden
expanse of Rhossili Bay, one of the finest
beaches in all of Wales.

Just metres from the hotel and National
Trust car park, the cliff top view of the beach
is breathtaking, and shouldn’t be missed.
Rarely do you find such a glorious
opportunity to shoot incredible scenery with
so little effort. Below you the beach stretches

for almost three miles northwards in an
unbroken golden expanse, with continuous
breakers rolling in off the Atlantic.

Once your appetite has been whetted,
head down the footpath and onto the beach
itself, and wander over to the wooden object
poking up out of the sand. On an otherwise
empty expanse of beach, it’s hard to miss the
skeletal remains of the shipwreck Helvetia,
which ran aground here in 1887. The
shipwreck is incredibly photogenic, bearing
more than a passing resemblance to a
dragon’s head emerging from the sand.

After shooting Rhossili, return to the cliff
top car park and walk along the headland,
all the way to the Worms Head viewpoint

1
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DID YOU KNOW?
In 1823, in a cave close to 

Mewslade Bay, a scientist found the 
remains of a Paleolithic human 

skeleton. Known as the Red Lady,  
the bones are in fact from a young 

male believed to have died 
around 34,000 years ago. 

Adamisahighlyexperiencedandenthusiastic
workshopleader,withover25years'experience
teachinggroupsandindividuals.Hehasbeen
leadingphotographicworkshopsforoverten
yearstodestinationsallovertheUKand
internationally, includingCanada,USAandthe
FaroeIslands.Withapatient, friendlyandnot
overly-technicalapproach,Adamistheideal
tutortohelpdevelopyourphotography. Ifyou
wouldliketofindoutmoredetailsofworkshops
Adamis leading,pleasevisithiswebsiteat:
www.adamburtonphotography.com

   ADAM BURTON’S WORKSHOPS
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high and unbroken all the way to Port Eynon, 
where the cliffs give way to a sandy beach. 
Around the next headland, just past Oxwich 
Bay Beach, set time aside to visit beautiful 
Three Cliffs Bay. The further east you venture, 
the farmland thins out to be replaced by 
residential areas. Soon you will have reached 
Mumbles, on the outskirts of Swansea.

Here, right at the eastern tip of the 
peninsula, Bracelet Bay is worthy of a 
mention, particularly if you are looking for a 
location to shoot sunrise. The beach here 
faces eastwards towards Mumbles 
Lighthouse, and presents opportunities to 
capture the sun rising over the sea in the 
winter months. Regardless of tide levels, the 
beach makes a great location for a spot of 
photography. If the tide is low there is a lot of 
sand, but plenty of rocky ledges too, while at 
high tide the water is pushed right up to the 
larger ledges high up the beach, presenting 
excellent opportunities for wide-angle shots.

1) Rocks on the beach at Fall Bay on the Gower Peninsula.  
2) An enormous rusty anchor near Worm’s Head. 3) The 
sweeping expanse of Rhossili Bay from the clifftop viewpoint. 
4) Mumbles lighthouse photographed from the rocky shores 
of Bracelet Bay. 5) Beautiful sunset above Mewslade Bay.

5



1) Stormy sunrise above Llantwit Major beach at high tide.  
2) Looking along the distinctive golden limestone cliffs of 
Nash Point. 3)  Low tide at Traeth Bach near Dunraven Bay.  
4)Wave-erodedlimestoneledgesatDunravenBay.

1

RHOSSILIBEACH:Thiswide expanse ofsandybeach
faceswestwards towards theWorm’s Head peninsula
and is therefore ideallyplaced forshooting sunsets.
The best subject on the beach is the shipwreck, Helvetia,
but planyourvisit fora retreating tide to avoid the sand
around the shipwreck being spoilt by manyfootprints.

NASHPOINT:Tide permitting, thewide ledges ofNash
Point provide opportunities to shoot the sun setting over
the sea at anytime ofyear.Alternatively, arrangeyour
composition to capture the low, late sunlight turning the
layered cliffs to gold. Forthe best compositions, head to
the southern side of the beach.

BEST BEACHES TO SHOOT SUNSET

2

4

3
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Glamorgan Heritage Coast
Although the Glamorgan coast is only a short
drive south east from Gower, the landscape
has a very different feel to it. The limestone
cliffs all along this coastline are very
distinctive, consisting of golden horizontal
layers. Below these cliffs, a multitude of
eroded ledges stretch out towards the sea,
making perfect subjects for seascapes.

The Heritage Coast stretches for a mere
14 miles eastwards from Porthcawl, and for
much of that distance the steep cliffs run
continuously without much access to the
shore below. However, the few areas where
the cliffs do fall away provide access to some
of the most photogenic beaches to be found
anywhere in Wales.

Probably the most well known of these
beaches is Dunraven Bay. If you like shooting
wide-angle seascapes, Dunraven will provide
you with all the foreground you could hope
to find. Smooth, wave-eroded ledges can be
found high up on the eastern side of the
beach, while some very different pock-
marked ledges frequent the western side.
In-between, a wide stretch of golden sand
is broken occasionally by tidal pools, which
are perfect for reflecting colourful sunsets.

An equally impressive location can be
found at Nash Point, just a short distance
along the coast. A toll road provides access
to a small cliff top parking area, from here
take a path down towards the shore. Nash
Point benefits from very similar geology to
Dunraven Bay, but with far less sand and
more rocky ledges. It’s most distinguishing
feature is the unusual triangular cliff that
makes a fabulous backdrop to any picture.

Lesser known is the wonderful beach near 

the village of Llantwit Major. As with the other
locations along this stretch of coast, the cliffs
have the same distinctive golden layers with
eroded ledges below. What makes Llantwit
Major beach special is that it faces eastwards,
so makes a perfect location to shoot sunrise.

Whichever beach you decide to head to,
pay attention to the tide. The tidal range here
is enormous, and at high tide all of the
beaches are mostly covered. Sometimes low
tide can be just as problematic, with the mass
of exposed ledges making compositions
busy and confusing. It's best to visit during a
mid-tide, ideally when it's retreating to save
any risk of becoming cut off.

DID YOU KNOW?
Dunraven Bay is also 

occasionally used as a TV and 
film location. The beach even 

doubled as Cornwall in the 
recent BBC Poldark series!



MEWSLADEBEACH:Beautiful Mewslade faces roughly
southwards so is best photographed at sunset inwinter
as the sun descends to the southwest. Head to the beach
when the tides are lowerand retreating to avoid the risk
ofbeing cut off.Tryto create compositions that include
some of Mewslade’s fascinating and unusual rocks.

DUNRAVENBAY:Dunraven Bayreallydoes have it all
forseascape photography, but forsunset it’s hard to beat
shooting up close to one ofthe beach’s tidal pools.
There should be numerous pools all overthe sandyarea
ofbeach, each formed around a huge rectangularrock 
chunk, which fell long ago from the cliffs above.

PORTHCAWL:Porthcawl mayappearto be a seaside
resortwith little to offera photographerbut, belowthe
sea front, the beach is packedwith rockyledges and
interesting geology.With awide area to explore, there are
opportunities to shoot sunset throughout theyear.Avoid
high tideswhen the ledges are mostlysubmerged.
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CANONEOSR6
PHOTO KITTESTED & RATED BYEXPERTS
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SPECIFICATIONS
Price:£2,449(bodyonly)
gImagesensor Full-frameCMOS

Lensmount:CanonRFmount
Resolution:20.1-megapixels

gMaximumimageresolution: p5472x3648pixels
yAFsystem: pDualPixelCMOSAFIIphasedetection

with6,072points
gMetering: g g384-zoneTTLusingimagesensor:

gEvaluative,Partial,Spot,Centre-weighted
ISOrange:Auto+ISO100-102,400;

expandsto50-204,800forstills
pShutterspeeds 1/8000sec-30secondsandBulb

Continuousframerate:20frames-per-second(fps)
withelectronicshutter,12fpswithmechanicalshutter

LCD: g3in1.62million-dotvari-angletouchscreen
Finder:0.5in3.69million-dotOLED

electronicviewfinder
gStorage:DualSDXCUSH-II

Size 138.4x97.5x88.4mm
Weight:680g(includingbatteryandcard)

Website:www.canon.co.uk
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C
ANON ANNOUNCED THE EOS R6 at
the same time as the EOS R5. While
both are full-frame mirrorless
cameras with lots of features in

common, the EOS R6 has a 20.1-megapixel
sensor, whereas the R5 has an effective pixel
count of 45-million pixels. Crucially, the EOS
R6 also costs £1,750 less than the R5, which
means it will appeal to more photographers.
It also has some very impressive credentials,
not least a very similar sensor design to
Canon’s flagship DSLR, the EOS-1D X Mark III.

Like the EOS R5, the EOS R6 has a
magnesium alloy chassis behind its
polycarbonate and glass resin outer shell. It’s
also weather-sealed to the same level as the
Canon EOS 6D Mark II. Overall, it has a nice
solid feel with most of the controls you need
within easy reach. Front and rear dials on the
top-plate and a large wheel on the rear let
you adjust settings quickly and easily when
the camera is held to your eye.

In addition, there’s a joystick on the back
of the camera that allows you to select the
AF point you want to use while you’re
looking in the viewfinder. I have quite large
hands for my height and gender but I found
the joystick a bit of a stretch for my thumb.
It means I have to adjust my grip on the 

camera to move from one AF point to
another. It’s not major issue as the EOS R6
isn’t the sort of camera that you’re likely to
use one-handed, but worth noting.

As it has a 0.5in-type screen, the EOS R6’s
viewfinder seems nice and big while the 
3.69-million dots provide a detailed view
with accurate exposure and colour.
Although fast-moving subjects seem to
move jerkily when the display performance
is set to ‘Power saving’, it’s still possible to
follow them in the viewfinder. Switching to
the ‘Smooth’ setting gives the movement a
more natural appearance.

On the back of the camera there’s a 3in
1.62-million-dot touchscreen mounted on a
vari-angle hinge. This enables you to see the
image when composing low or high-level
shots in landscape of portrait orientation.

As usual, Canon has done a great job of
combining touch control with button and
dial control. If you prefer, you can scroll
through the menu and make setting
selections using the navigation pad on the
back on the camera, but you can also tap on
options that you want to set. It really speeds
up using the menu.

There’s no avoiding a lengthy menu with a
camera that has as many features as the EOS
R6, but in addition to the Quick menu that’s
accessed by pressing the Q button on the
back of the camera, the main menu has a
customisable ‘My Menu’ section. This has up 

to six tabs, each with up to six items and it’s
well worth giving some thought as to how
you organise the features that you want to
access via this route. For example, I found it
helped to group together some of the
autofocus features in one tab and some
video-centric features in another.

Thanks to its sensor design, coupled with
the DIGIC X processing engine, the Canon
EOS R6 has a native sensitivity range of ISO
100-102400 for stills. This can be expanded
to ISO 50-204800. While I wouldn’t choose
to use ISO 102400 unless absolutely
necessary, the results are amongst the best
I’ve seen at that setting. There’s quite bit of
noise in the Raw files and the JPEGs are
rather smooth, but there’s no banding and
the colours are true. As a rule, however, I
would aim to make ISO 51200 the maximum
sensitivity setting. At ISO 25600 and below,
noise is controlled very well and there’s a
good level of detail.

As the EOS R6’s sensor has Canon’s Dual
Pixel CMOS AF II structure there’s phase
detection autofocusing with 6,072 points
spread across the whole area. That means
you can use the AF system with subjects

ear Enthusiast mirrorrlesscamera

It’smuchmoreaffordablethantheRR5
announcedatthesametimebutdoees
theR6haveenoughofwhatwewannt?

AngelaNicholsontakes it foraspinn

Test:ANGELA NICHOLSON

CANON
EOSR6

Above&right:TheCanonEOSR6isaverywellmade
modelwithaverylogicalcontrol layout.ThehingedLCDmodelwithaverylogicalcontrol layout ThehingedLCD
monitor makes it easy to use LiveView at unusual angles.
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Handling 19/20

Ease of use 18/20

Features 18/20

Performance 18/20

Value 18/20

Overall 91/100

close to the edge of the image frame.
There’s also Subject-detection with tracking, 
which can be combined with Eye-detection
and set to look for humans or animals.
What’s more it works with video or stills,
even at the maximum continuous shooting
rate of 20fps with the electronic shutter and
12fps with the mechanical shutter.

The EOS R6’s Subject-detection and
Eye-detection is amazingly good, it’s
stunning how small the eyes can be in the
frame and it will detect them. It can also spot
black eyes in black feathers or fur and follow
them around the frame and towards or away
from the camera. And it doesn’t need good
light, I was able to focus on someone's eyes
as they walked towards me in the dark.

While the EOS R6 doesn’t have the 8K
video capability of the EOS R5, it’s capable of
capturing superb-quality 4K video at up to
60p. At 25p there’s a slight crop (1.07x or
1.19x with the Digital IS on) and if you push
the frame rate to 60p there’s a 1.52x crop. 

Even without the digital stabilisation
activated, the EOS R6's in-body stabilisation
does a great job of making handheld
footage watchable – I even have some good
clips shot through the window of a moving 
train while I was standing holding the
camera. Unfortunately, however, heat
generation is an issue.

After shooting a 30min 4K clip, the
camera showed its heat warning a few
minutes into a second clip and it cut out
after recording 7:30 minutes. After a short
period of cooling, the camera was able to
record again but it cut out after less than ten
minutes. If you mainly shoot in short bursts,
or Full-HD it may not be a problem, but if
you want to record a lengthy interview it
could be significant issue, so it may well be
worth investigating this problem online
before purchase.

Overall, the EOS R6 is a fine choice if both
stills and video are important and you're
happy with its 20.1-megapixel resolution.

While 20.1-megapixels
doesn’t sound a lot by some
standards, the EOS R6’s
images are bigger than A3
size at 300ppi. They also have an excellent
level of detail, great colour and superb
noise control. The most impressive feature
is the AF system that’s simply brilliant
with moving subjects. It’s also capable
of producing very high quality video, but
the limitations to the 4K video recording
caused by heat generation are a concern.

ear

VERDICT

CLOSEST RIVALS
SONY A7 III: At £1,749 body only, this 

24-megapixel full-frame mirrorless camera is a 
great all-rounder and has an excellent AF system, 
butthemenuisrathercomplex.

NIKON Z 6: An attractively priced (£1,549 body 
only) 24-megapixel full-frame mirrorless camera 
with lovely handling and excellent control layout. 
Italsodeliverssuperbimages.

PANASONIC LUMIX S5: It’s only recently 
announced and yet to be tested but at £1,789 
body only or £2,079 with the 20-60mm lens, this 
24.2-megapixel L-mount full-frame model with a 
vari-angle touchscreen is an enticing alternative, 
with an impressive video specification.

IN-BODY IMAGE S BIT LISA ION
Likemanyrecentcameras, theCanonEOSR6
has in-bodyimagestabilisation(IBIS) thatshifts
theimagesensortocompensateforaccidental
cameramovements.Thisfive-axissystemcan
workintandemwiththeopticalstabilisationbuilt
intosomeRFlenses(excepttheRF600mmf/11
ISSTMorRF800mmf/11ISSTM)togivea
class-leadingshutterspeedcompensationofup
to8EV. Iwasn’tabletoreachthat levelof
compensationbutwhenshootingat70mmthe
ISwasabletogetaroundathirdofimagessharp
whenhandholding one-second exposures.

Exposure:1/125secatf/14(ISO100)
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ear  Software test

HDR SOFTWARE SEEMS to come and
go, perhaps because some options
simply aren’t as effective as they could

be, while others can be highly effective but
incredibly difficult to use. So, in an ideal
world, what we need is a balance between
these two characteristics – ease of use and
effective results, and with Aurora HDR 2019
that’s pretty much what we get.

The software can be as easy to use as you
want it to be with a large number of presets
that can be used in their entirety to process
HDR images, or used as a starting point from
which manual adjustments can be made.
And for more advanced users of the software,
you can also make fully manual adjustments
using many controls comparable to Raw
editing software, including localised
adjustments and even luminosity masks.

Powerful HDR processing software
with features that are suitable for

both beginners and experts

Test:JAMES ABBOTT

SPECIFICATION
Price: £92 (upgrade price upon application)

Mac: Model: Early 2010 or newer.
MacOS: 10.11 or higher. RAM: 8GB or more

Disk space: 10GB free space
Windows: Graphics: Open GL 3.3 or later compatible

Processor: Intel Core i5 or above. OS: Windows 7 
or higher (only x64-bit OS). RAM: 8GB or more

Disk space: 10GB free space
Website: www.skylum.com

SKYLUM 
AURORA 
HDR 2019

The results of Aurora HDR 2019 range 
from completely natural all the way to in 
your face grungy HDR with strong use of 
clarity and structure, and all this is with the 
promise of no halos or artefacts as a result of 
artificial intelligence. The software also 
works standalone or as a plug-in for Apple 
Photos, Photoshop, Elements and 
Lightroom, so it can fit seamlessly into  
your existing editing workflow.

 USEABILITY AND PERFORMANCE: The Aurora 
HDR 2019 interface looks much like any 
other editing software with a large image 
window in the centre, control panels to the 
right, the main menu and the ability to open 
the Aurora HDR Looks Panel, which are 
presets at the bottom of the interface. The 
HDR Looks themselves can serve as either an 
endpoint for editing images for beginners or 
as a starting point for more advanced users 
who intend to refine the effects using the 
manual controls on the right. 

HDR Looks are a matter of personal taste, 
they certainly won’t be for everyone. But with 
presets created by Skylum covering basic 
looks, subjects and styles, as well as presets 
created by well-known HDR photographers 
Trey Ratcliffe, Serge Remelli and Randy 
VanDuinen, there are a huge amount of 
options available to experiment with.

The software is relatively easy to navigate 
and control and any users of software such 
as Adobe Lightroom, Affinity Photo or 
Skylum’s Luminar 4 will find themselves in 
familiar ground, with the control panel on 
the right employing slider-based controls. 
There are, of course, controls specific to 
HDR processing, but for the most part detail 
recovery is performed using Shadows, 
Highlights, Whites and Blacks sliders and 
localised adjustments such as the Brush, 
Radial Mask and Gradient Mask. This means 
that no knowledge of tone compression 
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Above: Aurora HDR 2019 is one of the most fully-featured 
software options designed specifically for processing HDR 
images. Controls are on par with Raw processing software 
and provide the ability to create natural-looking images or 
thestronggrungylookthatsomephotographersprefer.

controls is required and that taking images
from looking natural to a strong HDR is an
incredibly simple process.

Software performance is good with no
slowdowns or major issues, although
sometimes there can be a slight delay
between applying an adjustment and the
result rendering on the image in the image
window. Also, controls such as White
Balance are sensitive, so you may find that
the amounts you need to input when
working with Raw files are lower than 
required in other software.

FEATURES AND IMAGE QUALITY:The software
benefits from a new Quantum engine,
which is the algorithm behind the software
powered by artificial intelligence, and helps
to prevent problems typical of HDR, such as
halos and artefacts, from occurring in
images. This certainly works well, and it’s
pretty much impossible to push images so
far that they suffer from these problems.
Overall, image quality is fantastic, particularly
when working with Raw files, which
naturally provide a much greater level of
image data to work with. Although you can
also process bracketed JPEGs and TIFFs, as 

well as creating HDR style results from single 
exposures opened in the software.

HDR specific controls include HDR
enhance for controlling clarity and
structure, HDR Denoise for reducing noise
and HDR Details Boost which apply a kind of
sharpening effect to different types of detail 
in images. As well as all the standard

controls for adjusting images there’s also
the ability to apply LUTS for colour effects
and Color Toning (split-toning), which both
help you to achieve more unique looks.
One tool that’s unfortunately missing is a
healing brush for removing dust spots when
working with Raw files, but these can be 
removed in other software.
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Ease of use

Features

Performance

Value for money

Overall

As far as HDR software
goes, Skylum has created
one of the best options
available for both Mac and
Windows PCs. Thanks to an intuitive
interface and excellent image quality,
the software is suitable for all ability levels,
although the more familiar you become
with the software the more you can
naturally get from it. The manual controls 
and localised adjustments that can be
applied on Layers are where you can
really take control of processing.

In terms of performance, Aurora HDR
2019 runs well and the ability to also install
it as a plug-in for Apple Photos, Photoshop,
Elements and Lightroom is extremely
useful for integrating the software into your
existing image editing workflow. Using
the software standalone, however, is a
simple way of working and doesn’t impact
negatively on the workflow.

At £92 for a perpetual license of Aurora
HDR 2019, it’s certainly not the cheapest
option available but you only need to
pay for it once. And in terms of features,
usability and image quality, it’s money well
spent if HDR photography is something you
enjoy. And while Lightroom is capable of
processing excellent HDR images, Aurora
HDR 2019 has the edge, so with a free trial
available for download, it’s worth trying.

VERDICT



Brilliant interactive 
display
with Smooth Touch

B line touch monitor

Available at:
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OVERALL

VERDICT

You'llnormallyfindlotsoffaults 
withafirst-generationproduct, but 
that'snot thecasewithPgytech's 
OneMo. It'sdesign isclearly well 
thoughtoutanditsqualityand comfort is excellent.  
It'salsopricedverycompetitively too. Well worth a try!

Y
OU MOST LIKELY haven't heard ofY
Pgytech – I hadn't until this Chinese
brand contacted me about its
OneMo backpack. It's the product of

a successful Kickstarter campaign, with its
founders being a group of experienced
photographers wanting to create a storage
solution that meets all their requirements.
I have to say on having used this bag for a
number of weeks, I'm very impressed.

The OneMo's main compartment has
a versatile inner design for housing a
camera or drone outfit, along with a 15in
laptop in a slip-in section. It uses thin but
hard ribbed dividers to customise the
space to suit your outfit. You can easily fit
a couple of camera bodies and half a
dozen lenses, or a smaller camera kit and
drone or gimbal. Along with the main
zipper to reveal the entire main section,
there are two side-access entry-points
too. When unzipped, you'll find these
entry areas contain a pocket for a wallet/
purse in one and three spare battery
pouches (with useful sliding red/green 

charge indicators) on the other. Inside the
backpack is a pouch that can be removed
and used around the waist or over the
shoulder – it's big enough to hold a
camera body and an extra lens for when
you travel light. On the OneMo's front is a
very large pocket that can hold additional
items such as clothing and be expanded if
required. This allows the backpack to have
a very useful maximum capacity of 30
litres with the pouch giving an extra five
litres, too. You'll also find lots of loops and
straps around the bag for attaching
smaller items too.

The build quality of the OneMo is
excellent – the polyester fibre exterior is
scratch- and water-resistant (a separate
rain cover is included for when conditions
take a serious turn for the worse) and the
zippers are very high quality. The comfort
rating is excellent as well – the harness and
thick straps ensure the backpack stays tight
to the body, with air vents to reduce the
amount of heat and sweat on your back.

The size and features of the OneMo
make it an excellent choice for the
modern photographer who uses different
types of kit, but is also suitable for more
traditional users too.

Abackpackwith removable pouch designed forcamera and drone outfits

PgytechOneMobackpack
Test:DANIELLEZANO

I have to admit it took me
a long time to warm to
sling straps. For years
I hung my camera
over my shoulder
using a traditional
wide Optech strap.
However, a couple
of years ago I tried
out a BlackRapid sling
strap and was surprised
by the benefits it offered.
Along with walking with the camera
hanging loose against my torso so I had
both hands free, the camera could be
raised to the eye quicker than when it
was attached a standard strap.

The Delta Sling is one of BlackRapid's
latest products, designed to be fast and
secure in use with DSLRs or mirrorless
cameras. The shoulder pad is long and
thick and its straight design provides a
high degree of comfort whether used
over the left or right shoulder. Nylon
loops allow for accessories to be fitted in
the future. The camera attaches via the
tripod bush to a circular mounting plate
that fits to a thick and strong caribiner.
While its unnerving at first to release your
hold on the camera so that it hangs
down, you'll soon get to trust it. To keep
the camera in your favoured position,
the strap has two spring-loaded cam
locks to prevent it slipping along the
strap. Available in black or black/coyote
finishes, the Delta proves to be a
versatile, comfortable and secure
shoulder strap, although a small drop in
price would make it even better value.

SPECIFICATION
Guideprice:£75

p gStraplength:167cm
Length(shouldertooppositehip):Max.81cm

gWeight: g162grams
Included: yCarabiner,LockStarBreatheaccessory,
FastenR5connector,safetytether,storagecase

Website:www.phototeq com

Test:DANIEL LEZANO

SlingstrapforDSLRsandmirrorless
/ Forright- and left-handed users

OVERALL

VERDICT

If you like the idea of being able to 
keep your hands free but have your 
camera easily accessible, then a sling 
strap is a great option. The Black Rapid
Delta is very well made, versatile and comfortable in 
use – it's well worth consideration.

LACKRAPIDDELTL AT
CAMERA SLING

teq.com

SPECIFICATION
GuidePrice:Around£199

Externaldimensions(backpack):480x320x230mm
I pnternaldimensions(backpack):470x300x170mm

p p pLaptopcompartment 385x270x26mm
E pxternaldimensions(pouch):270x180x120mm
I pnternaldimensions(pouch):260x150x115mm

C p y papacity(backpack):25-30litres
Capacity(pouch):Fivelitres
Weight(backpack):2.1kg

Weight(pouch):0.4kg
Website:www.pgytech.com

Aboveandleft:ThePgytechOneMoisa
versatile backpack and includesapouch.
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TESTED: SEPTEMBER 2017  RATING 91/100

TESTED: OCTOBER 2019  RATING  84/100 TESTED: AUGUST 2017  RATING 88/100
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Lookingtobuyyourfirstcameraoranupgradedmodel?Here’snineofourmosthighly-ratedDSLRsandmirrorlessmodels 

Digital cameras: Our favourite models under£1,500

NIKOND3400

NIKOND7500

CANONEOS250D NIKOND5600
pGuideprice:£499withAF-P18-55mmVP R

I gmagesensor:APS-C g p/24.2-megapixels
Website:www.nikon.co.uk

Guideprice:£899(bodyonly)
I gmagesensor:APS-C g p/20.9-megapixels

Website:www.nikon.co.uk

pGuideprice:£559with18-55mmISSTM
I gmagesensor:APS-C g p/24.1-megapixels

Website:www.canon.co.uk

pGuideprice:£579withAF-P18-55mmVP R
I gmagesensor:APS-C g p/24.2-megapixels

Website:www.nikon.co.uk
One ofthe bestvalue entry-level DSLRs on the
scene – keep an eye out forthe standard kit on
offerat main photo retailers forunder£420! It

features 11-pointAFand a 24.2-megapixelAPS-C
sensorthat delivers excellent results. It's small and

light and has a neat Guide Mode forbeginners.g

Ifyou're in the market foran advanced DSLR and
aren't bothered byfull-frame, then the D7500

should be onyourshortlist. It's smaller, lighterand
more affordable than the popularD500, but

delivers similarhigh image qualitythanks to using
the same sensor.Agreat all-round camera. 

Canon has a long historyofproducing excellent
entry-level DSLRs and this one continues the

trend, although a drop in pricewould be
welcomed.The nine-pointAFsystem is basic but
the excellent 24.1-megapixelAPS-C sensorand

4Kvide bilit k it d t t model.eo capabilitymakes it a good starterm

This is one ofthe best upperentry-level models
currentlyavailable. It's lightweight at only465

grams but is nicelyput together. It has an excellent
specification but is also easyto use, making it a

good choice ofcamera forbeginners looking fora 
model theycan advance theirskillswith.y

DIGITAL SLR

DIGITAL SLR

DIGITAL SLR

TESTED: JULY 2017  RATING 89/100

CANONEOS77D
Guideprice:£699withEF-S18-55mmSTM

Imagesensor:APS-C/24.2-megapixels
Website:www.canon.co.uk

This is an excellent upperentry-level model that
will suit beginners and enthusiasts alike. Build

quality is excellent,with Canon's familiarcontrol
layout making it easyto operate, even fornovices.
The sensordelivers high-qualitystills and Full HD

video and boasts responsive Dual PixelAF.

DIGITAL SLR

DIGITAL SLR

TESTED: AUGUST 2020  RATING 89/100

FUJIFILMX-T200-
Guideprice:£749withAF15-45mm

Imagesensor:APS-C/24.2-megapixels
Website:www.fujifilm.co.uk

This recent update ofthe X-T100 proves to be one
ofthe best entry-level models available.Aswell as
being a fine stills camera, it's also a solid choice for

video shooting, in particular forvloggers. Only
downsides are a fewhandling niggles and noise

levels at higherlevels at higher ISISO ratingsO ratings.

MIRRORLESS

TESTED: MAY 2019  RATING 92/100

FUJIFILM X-T- 30
Guideprice:£899withXC18-55mm

Imagesensor:APS-C/26.1-megapixels
Website:www.fujifilm.co.uk

This mid-range mirrorless model is one ofour
favourite cameras under£1,000. Beneath the
stunning retro designyou'll discovera camera

packedwith features including a brilliantAPS-C
sensorand X-ProcessorPro 4 imaging engine that

delivers stunning images and 4Kvideodelivers stunning images and 4Kvideo.

MIRRORLESS

TESTED: SEPTEMBER 2020  RATING 93/100

FUJIFILM X-T- 4
Guideprice:£1,549(bodyonly)

I gmagesensor:APS-C g p/26.1-megapixels
Website: jwww.fujifilm.co.uk

It maysport the sameAPS-C sensoras its
predecessor, but this updated flagship model

boasts awealth of improvements – in particular to
itsAFsystem, aswell as the addition of

body-integral image stabilisation – that helps
make it one ofthe best cameras on the market.ke it one ofthe best cameras on the mar

MIRRORLESS

If you’re lookingtobuy a camera,check out theoffers from theUK's best photo dealers in this issue for the very best prices

TESTED: MARCH 2018  RATING 93/100

PANASP ONICLUMIXG9
Guideprice:£899(bodyonly)

Sensor:M g picroFour-Thirds/20.3-megapixels
Website: pwww.panasonic.co.uk

Based on the excellent LUMIX GH5 butwith more
emphasis on stills photographythanvideo, a

majorprice drop makes it greatvalue. Speed is at
the heart of the G9,with a 20 frames-per-second

shooting mode and fast and responsiveAF.Agreat
choice ifyou regularly shoot wildlife or action.

MIRRORLESS
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If you’re lookingtobuy a tripod,check out theoffers from theUK’s best photo dealers in this issue for the very best prices

earBuyingadvice  

Every photographershouldownalightweightandsturdytripod.Wehighlightourfavourite models

Essentialphoto accessories:Tripods

MANFROTTOGTBET FREEXPROCO ARC BONMANFROTO TO MT055CXPRO4
pGuideprice:£299

gLegsections:Four gWeight: g1.74kg(inchead) 
Website:www.manfrotto co uk

pGuideprice:£299
gLegsections:Four gWeight: g2.1kg

Website:www.manfrotto.co.uk

Travel tripods are one ofth
most populartypes ofcam
support and this model is
of the best.Aimed at
enthusiasts and professio
it sports a solid build and a
excellent range offeature
including a neat centre-
column mechanismcolumn mechanism.
The supplied 496 ball
head is excellent too.

Professionals requiringan
extremelyrigidyet
lightweightsupportcons
thismodel tobeoneofth
best.TheG-Lock
twist-action locksare fast
andeasytouse,while
thechunkylegsextend
fromamin heightof10cmfromamin.heightof10cm
amaximumof198cm.Th
ultimate instability, atapr

Manfrotto's renowned 055-series has changed a
lot overtheyears but has always delivered high
performance.Thisversion addswelcome new
features, including a tilting centre-column and

heavydutyQuick PowerLocks. Excellent stability, 
even at its maximum height of140cm.
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manfrotto.co.uk
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BENROSLIMTAT LLTSL08CLN00KIT
pGuideprice:£140

Legsections:Four Weight:1.09kg
Website:www.benroeu.com

The limited-editionversion oftheTSL08CN00
offering an additional 18cm ofheight, making it
more suitable fortall users. It's lightweight and

relativelycompact size makes it a good choice for
travel aswell as standard use. It has a stored length

of 55.1cm and maximum height of135cm.

TESTED: MARCH 2020  RATING

TESTED: JANUARY 2020  RATING

BENROGOPLUSCS LASSIC TGP17CT
pGuideprice:£170

Legsections:Three Weight:1.38kg
Website:www.benroeu.com

An oldermodel but still available in limited
quantityat far less than its original price (£309).

Boasts reallyuseful andwell implemented
features to gowith a high overall performance
and modestweight, including an articulating

centre-column and monopod facility.yy

TESTED: NOVEMBER 2017  RATING

MANFROTTOELEMENTSMS II
pGuideprice:£115

Legsections:Four Weight:1.55kg
Website:www.manfrotto.co.uk

This aluminium tripod is one ofthe best budget
models available. Small enough to be used as a

travel tripod, it comes suppliedwith a good quality
ball headwith a payload up to 8kg. It's a sturdy
model that uses twist-locks forfast and easy
set-up and has a maximum height of160cm.

TESTED: OCTOBER 2020  RATING

TESTED: NOVEMBER 2017  RATING

MANFROTO TO MT057C4-G
pGuideprice:£649

Legsections:Four Weight:3.75kg
Website:www.manfrotto.co.uk

Atop ofthe range tripodwith stabilityat its core,
at the expense ofadditionalweight. It isvery
well engineered,with great strength and a

maximum height of182cm that can be raised to
206cmvia the geared column. Ideal forthe studio

or outdoors, if you're happy to lug it ou

TESTED: NOVEMBER 2016  RATING

GITZOSYSY TEMATIC5543XLSSC ERIES5XL
pGuideprice:£999

Legsections:Four Weight:3.1kg
Website:www.gitzo.co.uk

n

ider
e

 

mtomto
e

rice.

TESTED: FEBRUARY 2019  RATING

GITZOGT2545T WITH1382QDHEAD
pGuideprice:£619

Legsections:Four Weight:1.48kg
Website:www.gitzo.co.uk

The price is high but this exceptional travel tripod
from Gitzo could possiblybe the one and only

tripodyou'll everneed. Construction is sublime, as
is handling,while the 1382QD ball head is first rate

too. Stored it measures 44cm, increasing to
129cm (153cm with column raised))).

TESTED: JULY 2016  RATING

pGuideprice:£269
gLegsections:Four gWeight: g1.5kg(inchead)

Website:www.benroeu.com

This is a compact and lightweight travel tripod
(with monopod option), offering good support
and just enough height (121cm, extendable to

145cm) formost. It closes down to 44cm foreasy
storage.The suppliedV0E ball head is no more

than average,which is a little disappointing.

TESTED: JULY 2016  RATING

BENROTRAVEL ANGEL FTAT 18CV0
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PAGES OF ESSENTIAL
PHOTO TECHNIQUE,  

EXPERT ADVICE & 
INSPIRATION

164

Get your copy for only £10 at store.rpipress.cc
Or FREE with our fantastic subscription offer on page 96

Master landscapes and 
improve your photo skills...



THE PHOTO AND VIDEO EDITING 
CONSOLE. CREATIVE, FAST,
ERGONOMIC, INTUITIVE.
COMPLETE CONTROL
AT YOUR FINGERTIPS.
FIND YOUR EDITING FLOW *

*The £199 Loupedeck+
is available for purchase
at Wex Photo Video and
Amazon.co.uk. Loupedeck+
is compatible with Adobe
Lightroom Classic CC, 
Promiere Pro CC,
Photoshop CC and
Skylum Aurora HDR.

loupedeck.com
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CHERYL HAMER
PHOTOGRAPHY

WORKSHOPS & HOLIDAYS THAT ARE ‘INSPIRATIONAL’ 
(workshop participant October 2019)

Cheryl runs workshops and holidays to suit all levels of photographer and gets constantly

excellent customer feedback. Her teaching style is clear and practical and can help you to  

‘get off auto’ or to learn more advanced photographic impressionism techniques.

Book online at www.cherylhamer.com
Gift vouchers to any value also available by emailing cheryl at hello@cherylhamer.com



ESSENTIAL PHOTO ADVICE TO HELP YOU IMPROVE YOUR PHOTOGRAPHY
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GIFTS GUIDE
It’s hard to think that 

Christmas isn’t far away!  
We offer ideas on what every 

photographer might want

CANON EOS R5
How does Canon’s professional 
mirrorless model compare to 

rivals? And is it a better buy than 
the EOS R6 tested this month? 

PHOTO SKILLS
From light trails to creative 
still-lifes, we’ve a range of 

camera and editing techniques 
for you to try this month

Plus

WITH LESS PEOPLE ON THE STREETS OF TOWNS AND CITIES, NOW’S THE TIME TO CAPTURE BUILDINGS NEW AND 
OLD. IN THE NEXT ISSUE, WE’LL ARM YOU WITH THE SKILLS AND KNOW-HOW FOR WHEN LOCKDOWN IS LIFTED

 Photo Expert



85mm F1.4

Redefining the classic.

Case, Hood with Lock (LH828-02) supplied 

Available in: L-Mount, Sony E-mount

*L-Mount is a registered trademark of Leica Camera AG.

Made in Japan


